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Why the name “Eudora”?
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In This Section . . .
■ Customizing the Main Toolbar

■ Adding, Moving, and Removing Toolbar 
Buttons

■ Main Window Icon

■  Right Mouse Button

■ Mail Storage

■ Printing

■ Plug-ins (Extended Messaging Services)

■ Messaging Application Program Interface 
(MAPI)

■ Putting Multiple Users on One PC



Eudora Reference Guide Customizing the Main Toolbar
Customizing the Main Toolbar

The Main Toolbar is a strip of buttons that gives you easy access to your 
frequently used Eudora commands.

                              Main Toolbar

The toolbar can be moved to wherever you want it on the screen. Just 
hold down the left mouse button on the gripper bar, which is the 
double-line at one end, and drag the toolbar around until you find a place 
you like. You can dock it to any edge of the Eudora window (left, right, 
top, or bottom), or you can dock it to another dockable window, or you 
can put it anywhere on your desktop in the “floating” state. (See the 
Eudora User Manual section “Managing Your Windows in Eudora” for 
more information on window and toolbar docking.)

Viewing the Main Toolbar

To show or hide the main toolbar, turn the Show toolbar option on or off 
in the Display Options.

If the Show cool bars option is turned on in the Display Options, the 
toolbar buttons have a flat look, and a button only appears raised when 
you position the mouse pointer over it. If this option is turned off in the 
Display Options, the toolbar buttons always appear raised.

To see a description of each toolbar button, position the mouse pointer 
over the button: a description appears in the status bar at the bottom of 
the main Eudora window (if the Show status bar option is turned on in 
the Display Options). If the Show toolbar tips option is turned on in the 
Display Options, a toolbar tip is displayed when you pause the mouse 
pointer over a toolbar button.
11
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Adding, Moving, and Removing Toolbar Buttons

Adding Toolbar Buttons

To add buttons to the main toolbar, right-click anywhere on the toolbar 
(even on a button) and select Customize... from the popup menu. The 
Customize dialog is displayed.

                     Customize Toolbar window

The Customize dialog contains six tabbed panels: General, Mailboxes, 
Plugins, Recipients, Stationery, and Personalities. Each of these panels 
lets you add toolbar buttons for functions related to the tab title.

The procedures for adding a toolbar button from each panel are similar. 
In each panel, you select an item from the category list on the left, and the 
corresponding button icons for that category are shown in the Button 
section on the right. You then click on one of the button icons and view a 
description of the button’s function in the Description field at the bottom 
of the panel. These descriptions also appear in the status bar of the main 
Eudora window (if the bar is currently displayed) when you position the 
mouse pointer over the button icon—in this case you don’t have to click 
on the button.
12
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Note. In these button descriptions, any instruction to hold down the Shift 
key means to do so when you are actually using the button from the 
toolbar, not when you are adding the button to the toolbar, and not when 
you are clicking on the button in the Customize dialog to view its descrip-
tion. For example, if you click on the New Message button in the main 
toolbar, a new composition window opens. If you hold down the Shift 
key and click on the New Message button in the main toolbar, the 
Message Options dialog is displayed, allowing you to select options for 
creating a new message (Personality and Stationery).

After reading the button’s description, if you wish to add that button to 
the main toolbar, drag the button icon to your desired position on the 
toolbar.

If you need help at any time during toolbar customization, click the Help 
button in the Customize dialog.

When you are finished adding toolbar buttons, click the Close button to 
close the Customize dialog.

Following are specific instructions for the tabbed panels of the Customize 
dialog:

■ General – The Categories list contains names of menus and 
submenus. The buttons correspond to commands on these menus and 
submenus. (See the section “Menu Commands” in this Reference 
Manual for more information on the functions of these commands.)

■ Mailboxes – The Mailboxes list shows the same view as your Mail-
boxes window, accessed by selecting Mailboxes from the Tools 
menu. To add a toolbar button for a mailbox, click on the mailbox and 
drag the appropriate button to the toolbar. If the mailbox is in a closed 
folder, double-click on the folder icon to open it and display its 
contents (or click on the plus-sign [+] to open the folder), then click on 
the mailbox and drag the desired button to the toolbar. Note that you 
cannot add a toolbar button for a mail folder. (For more information on 
the Mailboxes window, see the Eudora User Manual section “Using 
the Mailboxes Window.”)

■ Plugins – The Plugins list shows installed message and resource 
plug-ins. You can add a plug-in button to the toolbar so that just by 
clicking on the button, you launch the plug-in application. Note that if 
you elected to install QUALCOMM’s PureVoice™ voice-messaging 
software plug-in when you installed Eudora, Eudora automatically 
13
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Customizing the Main Toolbar Eudora Reference Guide
adds a toolbar button for the PureVoice plug-in at the extreme right of 
the toolbar. (See the section “Plug-ins (Extended Messaging Services)” 
in this Reference Manual for more information on installing and using 
plug-ins.)

■ Recipients – The Recipients list on the left shows all recipients that 
are listed on your Quick Recipient List, which is the list of recipients 
you frequently send mail. (See the Eudora User Manual section 
“Using the Address Book and Quick Recipient List” for more informa-
tion on this list.) The buttons correspond to functions you can perform 
when addressing and sending mail to recipients on your list: New 
Message To, Forward To, Redirect To (all on the Message menu), and 
Insert Recipient (on the Edit menu). If there are no recipients on your 
Quick Recipient List, the Recipients area of this dialog panel is empty.

■ Stationery – The Stationery list shows all of your stationery files. The 
buttons correspond to stationery-related commands: New Message 
With, Reply With, and Reply to All With, all under the Message 
menu. (For more information on using stationery, see the Eudora User 
Manual sections “Using Stationery” and “Stationery Window.”)

■ Personalities – The Personalities list shows all of your e-mail 
accounts, if you use multiple accounts (multiple personalities). The 
buttons correspond to personality-related commands, such as the 
Message menu Change Personality command. (For more information 
on using multiple personalities, see the Eudora User Manual sections 
“Using an Alternate E-mail Account” and “Personalities Window.”)

Moving a Toolbar Button

To change the placement of a button on the main toolbar, hold down the 
Alt key and drag the button to where you want it.

Removing a Toolbar Button

To remove a button from the main toolbar, hold down the Alt key and 
drag the button off of the toolbar.

Adding and Removing Separators

To add a separator line between two toolbar buttons where no line 
currently exists, first determine which button is farther from the gripper 
bar when the toolbar is docked. Now hold down the Alt key and care-
fully drag that button a little bit in the direction opposite the gripper bar. A 
14
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separator line will be inserted between the two buttons. Be sure to drag 
the button less than one button-width away from its position; if you over-
drag it, you will hop over the adjacent button and reposition the dragged 
button on the toolbar.

To remove a separator line from between two toolbar buttons, again 
determine which of the two buttons is farther away from the gripper bar 
when the toolbar is docked. Now hold down the Alt key and drag that 
button in the direction toward the gripper bar. The separator line is 
removed. Alternately, you can hold down the Alt key and drag the other 
button slightly in the direction away from the gripper bar and that will 
remove the separator line. Again, be careful not to drag either button too 
far, or you will reposition it past the adjacent button on the toolbar.

The Main Window Icon

The main window icon displays when Eudora’s main window is mini-
mized on the Windows 95/NT 4.0 Taskbar. This icon provides a unique 
indication of when new mail has been delivered, when outgoing 
messages are queued, or both.

Normal
This is the normal state of the icon. There is no new mail and no messages 
are queued and waiting to be sent.

New Mail
The mailbox is open and has a letter in it, indicating that new mail has 
been delivered.

Queued Messages
The flag on the side of the mailbox is in the up position, indicating that 
you have outgoing messages queued for delivery.
15
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A New Mail notification icon in the Windows 95/NT 4.0 Taskbar Tray 
(clock area) also tells you when new mail has arrived. You can hold the 
mouse over the icon and a tooltip tells you how many messages you 
have. If you double-click on the icon, Eudora is brought to the fore-
ground. The icon goes away when you click the mouse button, or press a 
key, inside the Eudora window.

The Right Mouse Button

The commands that are available from the right mouse button are gener-
ally the same as those on the main menu and toolbar: the right mouse 
button simply offers another access method.

To use the right mouse button commands, position the mouse pointer 
over a Eudora window and click the right mouse button (called a 
right-click), then select a command from the popup menu that is 
displayed. The contents of the popup menu vary depending on which 
window you are in and what tasks you might need to perform while in 
that window.

Right-click in an open incoming message and select View Source (if 
available) from the popup menu to view the formatting of the HTML text 
in a text file. Right-click in the message and select Send to Browser (if 
available) to view the HTML message in your Web browser.

If you want to turn the main toolbar or the status bar on or off in the main 
Eudora window, right-click on the gray area of the toolbar or status bar 
and select the item you want to show or hide: Toolbar or Status Bar.

New Mail/Queued Messages
The mailbox is open and has a letter in it and the flag on the side of the 
mailbox is in the up position, indicating that new mail has been delivered 
and outgoing messages are queued for delivery.
16
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If you have Eudora minimized as a button on the Windows 95/NT 4.0 
Taskbar, you can check for new mail without maximizing the Taskbar 
button. To do so, place the mouse pointer over the Eudora Taskbar 
button, click the right mouse button, and select Check Mail.

Mail Storage

When you install Eudora, it creates a number of files and directories 
within the assigned directory. In addition, Eudora creates additional files 
and directories as needed for mailboxes, signatures, stationery, nick-
names (Address Books), and other functions. The major Eudora files and 
directories are described below.

Attach Directory

Incoming attachments are saved in the Attach directory until you specify 
another directory using the Attachment directory button in the Attach-
ment Options (Tools:Options:Attachments). See the Eudora User Manual 
section “Receiving Attachments” for more details.

DirectoryServices Directory

Eudora uses the DirectoryServices directory to store the dll files for the 
Directory Services protocols that you use in the Directory Services 
window. See the Eudora User Manual section “Using Directory Services” 
for more details on these protocols.

Embedded Directory

Eudora uses the Embedded directory to store JPEG image files that you 
insert into the body of outgoing messages using the Insert Picture... 
command under the Edit menu. Eudora deletes these files from this direc-
tory when the messages containing the images are emptied from the 
Trash mailbox. See the Eudora User Manual section “Inserting Objects in 
Message Text” for more details.

Filters Directory

Filters are saved in the Filters directory. See the Eudora User Manual 
section “Filtering Messages” for more details on creating and using 
filters.
17
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Imap Directory

Eudora uses the Imap directory to store your IMAP mailboxes and 
messages.

Nickname Directory (Address Books)

Address Book entries are saved in the Nickname directory, in the default 
Eudora Nicknames file. If you have created additional Address Book 
files, they are kept under their own name in the Nickname directory. See 
the Eudora User Manual section “Using the Address Book and Quick 
Recipient List” for more details on creating and using Address Book files 
and Address Book entries (nicknames).

Plugins Directory

The EMSAPI plug-ins are kept in the Plugins directory. See the section 
“Plug-ins (Extended Messaging Services)” in this Reference Manual for 
more information.

Sigs Directory

The Standard and additional signature files are kept in the Sigs directory. 
These files are stored with the .txt extension. See the Eudora User Manual 
sections “Using a Signature” and “Signature Window” for more details 
on creating and using signatures.

Stationery Directory

Your stationery files are kept in the Stationery directory. Stationery files 
are stored with the .sta extension. See the Eudora User Manual sections 
“Using Stationery” and “Stationery Window” for more details on how to 
create and use stationery files.

descmap.pce

Mappings between mailbox names and file names are stored in the 
descmap.pce file.

Eudora.cnt, Eudora.hlp

The Eudora.cnt and Eudora.hlp files contain, respectively, the table of 
contents information and the help text for Eudora’s online help topics, 
accessed when you select Topics from the Help menu. These two files 
must be kept in the same directory.
18
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Eudora.exe

Eudora.exe is the Eudora application executable file. You may find it 
convenient to keep a shortcut of this file on your Windows desktop: 
double-click on the shortcut icon to open Eudora.

Eudora.ini

Your Options information is saved in the Eudora.ini file, along with other 
information. This file contains notes that describe each entry. For more 
information, see the “EUDORA.INI Settings File” topic in the Help Topics 
dialog of the online help (Contents tab), accessed by selecting Topics from 
the Help menu. Also see “The Options Dialog” in this Reference Manual 
for descriptions of many of Eudora’s options.

eudora.log, eudorlog.old

Eudora can keep records of all mail transfers. These records are kept in 
the eudora.log and eudorlog.old files. The eudorlog.old file is overwritten 
and a new eudora.log file is created when the eudora.log file reaches its 
approximately 100K maximum size. To enable logging, set the LogLevel 
entry in the [Debug] section of the Eudora.ini file. For more information, 
see the [Debug] section of the “EUDORA.INI Settings File” online help, 
accessed by selecting Topics from the Help menu.

filters.pce

Names and extensions for Eudora filters are saved in the filters.pce file.

finger.ini, LDAPInit.ini, ph.ini

The finger.ini, LDAPInit.ini, and ph.ini files are used to store settings 
information for the Finger, LDAP, and Ph protocols used in the Directory 
Services window.

in.mbx, out.mbx, trash.mbx

These files hold your mail. You’ll see files like these for every mailbox 
you create.

Note. These files are in UNIX mail format.

Note. Mail folders that you create are stored as directories with the .fol 
extension. Mail folders contain mailboxes and other mail folders.
19

QUALCOMM Incorporated



Printing Eudora Reference Guide
in.toc, out.toc, trash.toc

These files are the tables of contents for your mailboxes. They make it 
much faster for Eudora to access your mail. You’ll see files like these for 
every mailbox you create.

lmos.dat

This file contains information about the messages on your mail server. 
(lmos = leave mail on server.)

nndbase.toc

This file is the table of contents for your nicknames. Extra nickname files 
are stored in the Nickname directory (see above).

nndbase.txt

Your nicknames are saved in the nndbase.txt file. Note that this file 
contains the nicknames only, while the files in the Nickname directory 
(see above) contain the full data for each Address Book entry—which 
includes the nickname and more.

Readme.txt

This file contains the Eudora Readme, a text file that contains important, 
release-current information and instructions that might not be included 
in the Eudora User Manual, the Eudora Reference Manual, the Eudora 
Quick Start Guide, or the Eudora Online Help.

*.tlx

Dictionary information is stored in the .tlx files.

Printing

To print the current message or item, select Print... from the File menu. 
Eudora automatically prints headers and footers on each page, giving the 
window title, the page number, and your return address.
20
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Plug-ins (Extended Messaging Services)

Plug-ins are special add-ons that can be installed to add features to 
Eudora. For example, you could use a language conversion plug-in to 
translate a message to another language, a security plug-in to automati-
cally secure a message, or a text manipulation plug-in to change lower-
case to uppercase. Plug-ins interface to Eudora using the Extended 
Messaging Services Application Programming Interface (EMSAPI).

To make plug-ins available to Eudora, put them in the Plugins directory 
in your Eudora directory, then restart Eudora. Depending on the plug-in 
type, it will be available in Eudora in the following ways:

■ The Message Plug-ins submenu (under the Edit menu) typically 
includes plug-ins that are used to modify the text of a message. These 
are referred to as on-request plug-ins. Some samples of these types of 
plug-ins are available with Eudora: Sort, UpperLower, and Unwrap.

■ Icons in the message window are typically for plug-ins that are used 
to manipulate messages as they are sent or when they are received. 
These are referred to as on-transmission and on-display plug-ins.

■ The Tools menu typically includes plug-ins that are used to do tasks 
that are not directly related to Eudora functions. These are referred to 
as tools plug-ins.

■ The Attach submenu (under the Message menu) typically includes 
plug-ins that are used to create and attach particular files to a 
message. These are referred to as attachment plug-ins. (Example: 
QUALCOMM’s PureVoice™ voice-messaging plug-in, for recording 
and attaching voice messages to your outgoing messages.)

■ Plug-ins that are automatically used when a message is received are 
not available through the user interface. These are referred to as 
on-arrival plug-ins.

To see all of your currently installed plug-ins, select Message Plug-ins 
Settings... from the Special menu. The Installed Message Plug-ins 
dialog is displayed. If an installed plug-in has any settings options, you 
can use the Settings... button to change them. For information about 
available plug-ins, send e-mail to <eudora-rep@eudora.com> or visit the 
World Wide Web site <http://www.eudora.com>.
21
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The Messaging Application Program Interface 
(MAPI)

MAPI is an interface that lets you send e-mail messages from any 
MAPI-compatible application, such as your Web browser, word 
processor, spreadsheet, graphics application, etc. See the section “MAPI 
Technical Report” in this Reference Manual for technical details on the 
Eudora MAPI server.

MAPI-compatible applications have a Send or Send Mail option in the 
File menu. When you select the option, the Eudora MAPI server displays 
a new outgoing message with your current document attached. All you 
need to do is address the message, type any details you want to include in 
the body of the message, and click Send or Queue.

To run the Eudora MAPI server, set the options in the MAPI category of 
the Eudora Options dialog. To display the MAPI Options, select 
Options... from the Tools menu and click on the MAPI category (see “The 
Options Dialog” in this Reference Manual for more details).

You have several options in the MAPI Options dialog for loading the 
Eudora MAPI server. You can set it to always run or to run only when 
Eudora is running, or you can specify that it never run. These three 
options open or exit the server as soon as you select them.

Note. When you are running the Eudora MAPI server, Microsoft 
Exchange will not work. If you need to use Exchange, turn off the Eudora 
MAPI server.

You also have several options for saving or deleting MAPI attachments. 
When you use MAPI to attach a file and send a message, that file is imme-
diately copied into the Attach directory (or a directory you have speci-
fied). You can use the MAPI options to save those copies (never delete 
them ), or to delete them after sending their corresponding messages, or 
to delete them when their corresponding messages are emptied from the 
Trash.

Last, you have an option to send a single MAPI text file attachment (TXT 
and HTML files only) as an inline attachment — text in the body of the 
Eudora message — rather than as a “rider,” or normal attachment, to the 
message. So, for example, you can pass a Web page from your Web 
browser directly into the body of a Eudora message, for your recipients to 
read right in the message itself: they don’t have to open an attachment.
22
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Putting Multiple Users on One PC

If you have a multiple-user license for Eudora, you can set things up so 
that more than one Eudora user can be on a single PC. This also works if 
you have multiple e-mail accounts (multiple personalities), but you don’t 
want your alternate personalities to use the same set of mailboxes. You 
will need to exit and reopen Eudora to switch users or accounts.

To have multiple users on one PC, do the following:

1 Make a separate mail directory for each user (the directories can be 
put anywhere you like, including on floppies or network drives).

2 Put a copy of the Eudora.ini file into each user’s directory. 

3 For each user, create a shortcut to the Eudora executable file 
(Eudora.exe). 

4 Right-click on the new shortcut and select Properties.

5 Click the Shortcut tab. 

6 In the Target field, add the path to the user’s Eudora.ini file, as shown 
in the example below. To start Eudora, each user simply double-clicks 
on their shortcut.
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                         Specifying a mail directory
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Eudora Reference Guide Introduction
Introduction

From the Tools menu, select Options to display category windows where 
you can specify how you want to use Eudora. By selecting or deselecting 
criteria on these windows, you customize Eudora to suit your needs.

Options contains many categories, all of which are described in this 
section. When you first install Eudora, the Options windows contain 
preset settings.

Note. For your convenience, some options appear in more than one cate-
gory. For example, your return address appears in both the Getting 
Started options window and the Sending Mail options window. 
Changing an option in one category changes the option in all categories 
in which it appears.

Getting Started

On the Getting Started options window, you can determine the minimum 
information necessary to send and receive mail. The information here is 
for your “dominant” personality, which is your principal e-mail account.

Note.  For your convenience, some fields appear in more than one cate-
gory. For example, your return address appears in both the Getting 
Started options window and the Incoming Mail options window. 
Changing an option in one category changes the option in all categories 
in which it appears.

To display the Getting Started options window, do the following:

1 From the Tools menu, select Options.

2 Click the Getting Started icon. The Getting Started options window is 
displayed.
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                    Getting Started options window

Listed below are field descriptions for Getting Started:

Real name—This is the real name assigned to your principal account 
generally your first and last name. The text you enter here is included in 
the From field of all your outgoing messages from this account, and iden-
tifies to your recipients who the mail is from.

Return address—This is the return e-mail address used in outgoing 
messages and recipients’ replies, if this address is different from your 
incoming mail account. The address you enter here is included in the 
From field of all your outgoing messages from this account, and when a 
recipient replies to a message from this account, the reply is sent to this 
address. If you do not enter an address in this field, Eudora uses your 
incoming mail account as the return address. Incoming mail accounts are 
usually of the form loginname@incomingmailserver. For example, suppose 
your incoming mail account is beatrixp@wabbits.qualcomm.com but 
your return address is beatrixp@qualcomm.com slightly different. You 
would then enter beatrixp@qualcomm.com in this field.

Note. If you do enter an address in this field, first test the address to be 
sure that mail sent to it is indeed delivered to you. If you use an 
invalid return address, no one will be able to reply to your mail.
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Mail Server (Incoming)—This is the name of the incoming-mail server 
for your principal e-mail account. All incoming messages to your primary 
account are routed through this server. Use the Incoming Mail options 
window to specify whether this server uses POP (Post Office Protocol) or 
IMAP (Internet Message Access Protocol). A sample server name might 
be popserver.qualcomm.com.

Login Name—This is the name you use to log in to your primary e-mail 
account, for accounts that require a user login. For example, in the 
incoming mail account beatrixp@wabbits.qualcomm.com, the login 
name is beatrixp.

Checking Mail

The Checking Mail Options determine how Eudora checks for and 
receives incoming mail messages sent to your principal e-mail account, or 
dominant personality. 

To display the Checking Mail options window, do the following:

1 From the Tools menu, select Options.

2 Click the Checking Mail icon. The Checking Mail options window is 
displayed.

                        Checking Mail options window
29

QUALCOMM Incorporated



Incoming Mail Eudora Reference Guide
Listed below are field descriptions for Checking Mail:

Mail Server—This is the name of your incoming-mail server as entered in 
the Mail Server (Incoming) field of the Getting Started options. See 
Getting Started for more details.

Login Name—This is the login name you entered in the Login Name field 
of the Getting Started options. See the Getting Started section for more 
details.

Check for mail every ? minute(s)—If you enter a number greater than 
zero in this field, then at regular intervals, Eudora automatically checks 
your incoming mail server for new mail and transfers to your PC any 
mail addressed to your primary account. The number you enter here 
specifies the number of minutes between automatic mail-checks. It’s a 
good idea to set this at no less than 15 minutes. Checking mail more 
frequently puts an unnecessary drain on your incoming mail server. This 
option only works when Eudora is running. Entering 0 in this field turns 
off automatic mail-checking.

Don’t check when using battery—If this is on and your PC is running on 
battery power, mail is not automatically checked even if automatic 
mail-checking is on (that is, the Check for mail every ? minute(s) field has 
a number greater than zero in it).

Send on check—If this is on, any messages that are queued in the Out 
mailbox are sent when a mail-check is performed, whether the mail-check 
is automatic or manual. If this is off, messages queued in the Out box are 
not sent during a mail check.

Save password—If this is on, your password is remembered even if you 
quit and restart Eudora, so you’ll never be prompted to enter it. If this is 
off, you must enter your password each time you quit and restart Eudora. 
Only turn this option on if your PC is in a secure place.

Incoming Mail

The Incoming Mail options determine how Eudora receives incoming 
messages addressed to your primary e-mail account. The options 
configure the incoming mail server, whose name is entered in the Mail 
Server (Incoming) field in the Getting Started options window. 
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To display the Incoming Mail options window, do the following:

1 From the Tools menu, select Options.

2 Click the Incoming Mail icon. The Incoming Mail options window is 
displayed.

Listed below are field descriptions for Incoming Mail:

Server configuration—Specify which e-mail protocol the incoming mail 
server uses: POP (Post Office Protocol) or IMAP (Internet Message Access 
Protocol). If you are not sure which server to use, ask your e-mail admin-
istrator.

The options in the rest of this window depend on whether you’ve chosen 
POP or IMAP in this field. Options for both configurations are described 
below:

When Server configuration = POP:

                   Incoming Mail options window (POP)

Leave mail on server—If this is on, Eudora copies incoming messages to 
your PC and leaves the message on the POP server. If this is off, Eudora 
transfers incoming messages to your PC and deletes the message from 
the POP server. 
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Delete from server after ? day(s)—This option has a check box for 
turning it on and off and an edit box for specifying the number of days 
mail that was left on the POP server should be saved before being 
deleted. It is a good idea not to leave copies of your messages on the POP 
server indefinitely, as this will create mail storage problems on the server.

Delete from server when emptied from Trash—If this is on, any 
messages that are deleted from your Trash mailbox are also deleted from 
the POP server. 

Skip messages over ? K in size—If this is on, messages over the specified 
size are downloaded only in part. These messages include the first few 
lines, and a statement that says the message is not complete. This can be 
useful on slow connections.

Offline—If this is on, Eudora won’t attempt to make any connections. 
This is good to have on if you’re using Eudora on a laptop computer that 
is not continuously connected.

Authentication style—This specifies which POP account authentication 
technology to use for this account: Passwords, Kerberos, APOP, or RPA. 
Ask your e-mail administrator which one to use, if you are not sure. Use 
RPA for CompuServe.

Server configuration = IMAP:

                 Incoming Mail options window (IMAP)
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IMAP Mailbox Location Prefix—This specifies the mailbox location 
prefix that IMAP will use when locating your mailboxes on the incoming 
mail server. An example prefix is /usr/mail. Ask your e-mail adminis-
trator what to enter here, if you are not sure.

For new mail, download—These options (you must choose one) let you 
control the way incoming mail is downloaded from the IMAP server.

Minimal headers only—If this option is on, only a limited set of message 
headers, and nothing else, is downloaded for each incoming message. 
(That means the remaining message headers, the message body, and any 
attachments are not downloaded for the message.)

Full message except attachments over ? K—If this option is on, the full 
message (full set of message headers and the message body) and any 
attachments smaller than the specified size are downloaded for each 
incoming message. Also, any attachments larger than the specified size 
are not downloaded with the message. To download all of your IMAP 
attachments, enter a large number in this field.

Authentication style—This specifies which IMAP account authentication 
technology to use for this account: Passwords or CRAM-MD5. Ask your 
e-mail administrator which one to use, if you are not sure.

Sending Mail

The Sending Mail options determine how Eudora sends your outgoing 
messages from your primary e-mail account (dominant personality). 

To display the Sending Mail options window, do the following:

1 From the Tools menu, select Options.

2 Click the Sending Mail icon. The Sending Mail options window is 
displayed.
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                         Sending Mail options window

Listed below are field descriptions for Sending Mail:

Return address—This is your return e-mail address, if different from 
your incoming mail account. See Getting Started for more details.

Domain to add to unqualified addresses—This is the domain name that 
Eudora automatically adds to an unqualified address in messages sent 
from your primary account. An unqualified address is an address that 
doesn’t have an @ sign followed by a domain name. This can be used to 
save time when addressing large numbers of messages to users in the 
same domain.

SMTP server—This is the name of the outgoing mail server for your prin-
cipal e-mail account. All outgoing messages sent from your primary 
account are routed through this server. If the computer that your primary 
incoming mail account is on also runs an SMTP server, you can leave this 
field blank. SMTP stands for Simple Mail Transfer Protocol.

Immediate send—If this is on, the rightmost button in the Toolbar of the 
message composition window is labeled Send. Clicking on this button 
immediately sends the message to the SMTP server. If this option is off, 
the button is labeled Queue and clicking on it places the message in the 
Out mailbox marked ready for delivery (Q).
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Send on check—If this is on, any messages from your primary account 
that are queued in the Out mailbox are sent when mail is checked for this 
account, whether the mail-check is automatic or manual.

Select a default Stationery for new messages—This is the default statio-
nery to be used in all outgoing messages from your dominant account. 
Select a stationery file from the pop-up, or select <No Default> for no 
default stationery. If a stationery file is selected, that file is used when you 
open new messages from this account (except with the Redirect or Send 
Again commands). The message toolbar in the composition window is set 
according to how the stationery message was saved, regardless of how 
the options below are set. But, you can always change them after you 
open the message.

Select defaults when not using Stationery—The values you choose for 
the following options apply only when you are not using a default statio-
nery file, that is, when the Select a default Stationery for new messages 
option, above, is set to <No Default>., if you have selected a default 
stationery file in that pop-up, then the values below are ignored. Instead, 
Eudora uses their corresponding values that were set when the stationery 
file was saved. So, for example, if you choose default stationery that uses 
a custom signature and you set the Default signature pop-up below to 
your Standard signature, your Standard signature will be ignored and the 
custom signature will be used.

Default signature—This sets the default signature to be used in all 
outgoing messages sent from your dominant account. Select a signature 
from the pop-up, or select <No Default> for no default signature. If a 
signature is selected, that signature is used on the toolbar of new 
messages from your primary account. You can always change the signa-
ture in a particular outgoing message from the toolbar Signature pop-up. 
Default stationery overrides this option (see above).

Word wrap— If this is on, Eudora automatically inserts carriage returns 
in long lines when a message is sent, creating roughly 76 characters per 
line. This makes the message legible on the recipient’s computer. It is a 
good idea not to include your own carriage returns within paragraphs if 
you have this option on. Only use carriage returns to create new para-
graphs. We strongly recommend that you leave this option on. Default 
stationery overrides this option (see above).
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Keep copies—If this is on, a copy of each message you send is kept in the 
Out mailbox. If this option is off, outgoing messages are put in the Trash 
mailbox after they are sent. Default stationery overrides this option (see 
above).

May use quoted-printable—If this is on, Eudora uses quoted-printable 
encoding when necessary, such as when sending messages that contain 
special characters or long lines of text. If this option is off, quoted-print-
able encoding is never used. We recommend that you leave this option 
on. Default stationery overrides this option (see above).

Tabs in body of message—If this is on, pressing the Tab key within the 
message body inserts a tab. If it is off, pressing the Tab key within the 
message body moves the cursor to the To field. Default stationery over-
rides this option (see above).

Replying

The Replying options determine how replies are created.

To display the Replying options window, do the following:

1 From the Tools menu, select Options.

2 Scroll and click the Replying icon. The Replying options window is 
displayed.
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                            Replying options window

Listed below are field descriptions for Replying:

Map Ctrl+R to “Reply to All”—If this is on, then when you hold down 
the Ctrl key and press R, a new message is created addressed to all of the 
recipients of the original message as well as the sender.

Copy original’s priority to reply—If this is on, your replies use the same 
priority as the original message.

Automatically Fcc to original mailbox—If this is on, replies are automat-
ically copied to the same mailbox that contains the original message with 
the exception of the In box, whose replies are copied to the Out box.

When replying to all—This specifies how to address a reply. If Include 
yourself is on, when you Reply to all (as described above) your address is 
left in the address list of the new message and you receive a copy of your 
own reply. If this option is off (the default), your address is removed from 
the reply message and you do not receive a copy of the reply. If Put orig-
inal To: recipients in Cc: field is on (the default is off), the addresses of the 
original message recipients are moved from the To field to the Cc field of 
the reply-to-all message. Only the address of the original sender is placed 
in the To field.
37

QUALCOMM Incorporated



Attachments Eudora Reference Guide
Attachments

The Attachments options determine how Eudora sends and receives file 
attachments. 

To display the Attachments options window, do the following:

1 From the Tools menu, select Options.

2 Scroll and click the Attachments icon. The Attachments options 
window is displayed.

                          Attachments options window

Listed below are field descriptions for Attachments:

Encoding method—This specifies what encoding method to use for 
attached documents: MIME, BinHex, or Uuencode. To change the 
method for just the current message, use the Attachment Type popup in 
the outgoing message window. For details, see the section “Attaching a 
File to a Message.”

Put text attachments in body of message—If this is on, Eudora puts any 
plain-text attachment you send directly in the message body, as if it were 
typed in manually.
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Attachment directory—This specifies what directory to put incoming 
attachments into. To specify a folder, single-click on the folder name 
button. A dialog is displayed prompting you to select a folder.

Delete attachments when emptying Trash—If this is on, Eudora auto-
matically deletes an attachment received with a message when that 
message is deleted from your system, i.e., when the message is emptied 
from the Trash. The attachment must still be in the folder defined as the 
Attachments Folder. If you want to save an attachment but delete the 
message, move the attachment to another folder or turn this option off.

Delete automatic attachments—This specifies how to handle attach-
ments to automatically generated messages, such as is created with the 
Insert System Configuration command.

Never—If this is on, automatic attachments are never deleted from the 
attachment directory.

After sending message—If this is on, automatic attachments are deleted 
from the attachment directory when their corresponding messages are 
sent.

When message emptied from Trash—If this is on, automatic attachments 
are deleted from the attachment directory when their corresponding 
messages are emptied from the trash.

Fonts

The Fonts options determine how Eudora displays and prints text. Note 
that the choices available for each option, and the default, may depend on 
the fonts installed in your system. 

To display the Fonts options window, do the following:

1 From the Tools menu, select Options.

2 Scroll and click the Fonts icon. The Fonts options window is 
displayed.
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                              Fonts options window

Listed below are field descriptions for Fonts:

Message—These fields list the proportional and fixed-width fonts to be 
used for displaying the text in your received and composition messages 
and in the message preview pane in mailbox windows. Also included are 
the size of each font and the use of proportional or fixed-width font by 
default.

Proportional—Specify the proportional font to use in message windows 
and the preview pane.

Fixed-width—Specify the fixed-width font to use in message windows 
and the preview pane.

Use proportional font by default—If this option is on, message windows 
and the preview pane use your specified proportional font by default. If 
this option is off, message windows and the preview pane use your spec-
ified fixed-width font by default.

Size—Specify the size of the font to be used for text in message 
windows and the preview pane.
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Printer—These fields list the font and size to be used when printing any 
text from Eudora using the Print... command messages, text files, signa-
ture files, etc.

Font—Specify the font to use when printing text from Eudora.

Size—Specify the font size to use when printing text from Eudora.

Screen—These fields list the font and size to be used when displaying 
any Eudora screen text other than that displayed in received and compo-
sition messages and the message preview pane. This includes text files, 
signature files, and message summaries in mailbox windows.

Font—Specify the font to use when displaying all other screen text in 
Eudora.

Size—Specify the font size to use when displaying all other screen text 
in Eudora.

Display

The Display options determine how Eudora displays various objects in 
the main Eudora window and the category icons in the Options list. 

To display the Display options window, do the following:

1 From the Tools menu, select Options.

2 Scroll and click the Display icon. The Display options window is 
displayed.
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                              Display options window

Listed below are field descriptions for Display:

Show toolbar—If this option is on, the main window toolbar is 
displayed.

Show toolbar tips—If this option is on, holding the mouse pointer over a 
button in the main window toolbar displays a very brief description of 
that button’s function.

Show cool bars—If this option is on, the main window toolbar buttons 
have a flat look and only become raised when you position the mouse 
pointer over the button. If this option is off, the main window toolbar 
buttons always have a raised look.

Show status bar—If this option is on, Eudora displays a status bar at the 
bottom of the main window. The status bar provides a brief description of 
menu items and toolbar buttons.

Show category icons—This option allows you to turn the Category icons 
in the Options dialog on and off.

Show MDI task bar—If this option is on, Eudora displays the Eudora 
taskbar at the bottom of the window work area. This taskbar contains 
buttons for all open and minimized normal Eudora windows. 
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Viewing Mail

The Viewing Mail options determine how Eudora displays incoming and 
outgoing message windows and the message preview pane in mailbox 
windows. 

To display the Viewing Mail options window, do the following:

1 From the Tools menu, select Options.

2 Scroll and click the Viewing Mail icon. The Viewing Mail options 
window is displayed.

                        Viewing Mail options window

Listed below are field descriptions for Viewing Mail:

Message Window—These options determine how Eudora displays 
received and composition messages.

Use Microsoft’s viewer—If this is off, Eudora displays advanced format-
ting, graphics, and multimedia in incoming and outgoing messages, 
using its own built-in viewer. If this is on, Eudora takes full advantage of 
the Web browser capabilities of Microsoft’s Internet Explorer 3.0 or later 
by showing Web content right in incoming and outgoing messages or 
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linking to the Internet, without your having to open the Web browser. 
This option is only available if you have Microsoft’s Internet Explorer 
version 3.0 or higher installed and available on your system.

Message window width—This specifies the width of new and received 
message windows (in characters). This option has no effect on what your 
mail looks like when it is sent. When mail is sent, Eudora wraps at or 
before 76 columns.

Note. If you use a proportional font, Eudora sets the window width 
based on the average width of the characters in the font.

Message window height—This specifies the height of new and received 
message windows (in lines).

Note. If the Zoom windows when opening option is turned on, 
received message window heights are automatically adjusted to the 
height of the message text.

Preview Pane—These options determine the visibility and behavior of 
the message preview pane that appears at the bottom of mailbox 
windows.

Show message preview pane—If this option is on, Eudora displays the 
message preview pane in mailbox windows. The preview pane previews 
a single selected message. A splitter between the preview pane and the 
message summary list lets you resize the preview pane relative to the list.

Mark previewed messages as read after ? second(s)—If this option is on 
and the Show message preview pane option is turned on, the message 
currently selected in the mailbox window and previewed in the preview 
pane is automatically marked as read (blank in the Status column) after 
the specified number of seconds. If this option is off, a previewed 
message will not automatically be marked as read. Note: You can use the 
Shift+Space shortcut to convert a message back and forth between the 
Unread ( ) and Read status.

Automatically open next message—If this is on, deleting or transferring 
the current message opens the next message in the mailbox, but only if 
that message is unread.

Zoom windows when opening—If this option is on, new message 
windows automatically open to their “zoomed” size. The zoomed size is 
computed on a window-by-window basis. For message windows, 
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zoomed size is just long enough to display all of the message (but no 
longer than the main window), and as wide as the Message window 
width setting. Composition windows zoom to the height specified by the 
Message window height setting.

Show attachment icons—If this is on, the icon for an attachment is 
displayed, along with the attachment name, in the body of incoming 
message windows and the message preview pane in mailbox windows. If 
this is off, only the attachment’s name is displayed in incoming messages 
and the preview pane.

Mailboxes

The Mailboxes options determine how Eudora displays various objects in 
mailbox window columns. It also allows you to configure Eudora to 
select and drag message(s) for mailbox transfers.

To display the Mailboxes options window, do the following:

1 From the Tools menu, select Options.

2 Scroll and click the Mailboxes icon. The Mailboxes options window is 
displayed.

                           Mailboxes options window
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Listed below are field descriptions for Mailboxes:

Show Mailbox Columns—These options determine which columns are 
displayed in mailbox windows. Turn on an option to display that column 
in all mailbox windows. The options are Status, Priority, Attachment, 
Label, Sender, Date, Size, Server status, and Subject.

Show mailbox lines—If this option is on, lines are displayed in the 
message summaries portion of mailbox windows, horizontal lines to 
separate message summaries, and vertical lines to separate columns.

Close messages with mailbox—If this is on, all opened messages in a 
mailbox will close automatically when you close the mailbox.

Select newly inserted messages (FUMLUB)—If this is on, the first 
message of the most current block of unread messages is highlighted in 
the Table of Contents window. FUMLUB means First Unread Message of 
the Last Unread Block. For example, you may have a series of unread 
messages in a mailbox scattered throughout your Table of Contents. The 
first message of the last block of unread messages listed in your Table of 
Contents is selected. 

When dragging in a mailbox: drag and drop transfers—If this is on, you 
can transfer a message to another mailbox using drag and drop: select 
one or more messages in a mailbox, drag them to another mailbox and 
drop them in the target mailbox.

Allow drag select of messages—If this is on, you can click and drag on 
adjacent messages to select them as a group in the Table of Contents 
window. This allows you to transfer a group of messages to a mailbox or 
to delete them if the “Allow drag and drop transfers” is turned on. The 
drag select works only if the drag starts on an unselected (not high-
lighted) message.

Styled Text

The Styled Text options determine when to use style information in 
outgoing and incoming messages.

To display the Styled Text options window, do the following:
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1 From the Tools menu, select Options.

2 Scroll and click the Styled Text icon. The Styled Text options window 
is displayed.

                            Styled Text options window

Listed below are field descriptions for Styled Text:

Show formatting toolbar—If this is on, the formatting toolbar displays 
by default in new message windows. If this is off, the formatting toolbar 
is hidden by default in new message windows. This toolbar lets you 
easily format text styles in new messages.

When sending mail with styled text (HTML)—This specifies what to do 
with HTML text styles when you send mail. The styles are delivered to 
your recipients using the HyperText Marking Language (HTML) format. 
However, the styles your recipient sees depends on how well their e-mail 
software supports this standard. is the text formatting standard used in 
the World Wide Web by Web browsers and newer e-mail applications. 
HTML allows you use enriched text, which includes different fonts, color, 
sizes, bold, etc. Also, HTML lets you embed pictures and create bullet 
lists in the e-mails you send.

Send plain and styled version in message—If this is on, all text 
including plain and HTML text styles are sent with your messages. 
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Send styled text only—If this is on, only HTML text styles are sent with 
your messages. 

Send plain text only—If this is on, the HTML text styles are not sent with 
your messages, only plain text.

Ask me each time—If this is on, you are warned when you try to send or 
queue a message with text styles.

Spell Checking

These options control the behavior of Eudora’s built-in spelling checker 
when it performs a spelling check on the body of a message composition 
window, a text file, or a signature file. You can also change these options 
from the Spelling Options dialog, accessed by clicking the Options button 
in the Check Spelling dialog. 

To display the Spell Checking options window, do the following:

1 From the Tools menu, select Options.

2 Scroll and click the Spell Checking icon. The Spell Checking options 
window is displayed.

                      Spell Checking options window
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Listed below are field descriptions for Spell Checking:

Ignore capitalized words—The spelling checker ignores words that 
begin with a capital letter, such as proper nouns.

Ignore words with all capitals—The spelling checker ignores words that 
contain all capital letters, such as acronyms.

Ignore words with numbers—The spelling checker ignores words that 
contain numbers.

Ignore words with mixed case—The spelling checker ignores words that 
contain a mixture of uppercase and lowercase characters.

Report doubled words—The spelling checker reports words that appear 
twice in sequence in text and identifies them as Doubled words.

Suggest words—If this is on, then when the spelling checker encounters 
an unknown word, it displays Eudora’s suggestions for the correct 
spelling of the word in the Suggestions field of the Check Spelling dialog. 
You can also select any combination of the suggestion options: Phonetic 
words (off by default), Split words (on by default), Typographic words 
(on by default).

Note. If in its dictionary Eudora has no suggestions for the word, then 
no suggestions are listed.

Outgoing messages: original text—The spelling checker ignores any text 
that is preceded by a quote mark, which is a right angle-bracket (>) for 
plain text, and an excerpt bar (|) for styled text. Eudora assumes that this 
text was originally from another message, and therefore does not need to 
be spell-checked.

Check when message queued/sent—The spelling checker checks the 
spelling of outgoing messages when you use the Queue or Send 
commands.

Warn me when I queue/send a message: Without completing the spell 
check—If this option is on and the Check when message queued/sent 
option is on, Eudora displays a warning if you attempt to queue or send a 
message without completing the spell check.
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Date Display

The Date Display Options determine how message dates are displayed in 
the Date column of mailbox window message summaries.

To display the Date Display options window, do the following:

1 From the Tools menu, select Options.

2 Scroll and click the Date Display icon. The Date Display options 
window is displayed.

                         Date Display options window

Listed below are field descriptions for Date Display:

Display dates using—This specifies what time zone to use to display 
dates. 

Sender’s timezone—If on, messages are displayed with the sender’s time 
and date, as determined by the sender’s time zone. 

Local timezone—If on, messages are displayed with your time and date, 
based on your local time zone.

Date formats [default: Fixed]—These options and fields specify how to 
display message dates whether with a fixed or an age-sensitive format 
and the specific formatting for the selected option. A fixed format means 
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that all dates are displayed under the same formatting rule. An age-sensi-
tive format means that message dates are displayed differently 
depending on how old the messages are. Formatting is entered in the text 
fields using the format key at the bottom of the Date Display Options 
window (discussed further below).

Fixed [defaults: %1 %2 %4]—If this is on, all message dates are displayed 
using the formatting entered in the edit field, based on the formatting key 
(see below). The default format (%1%2%4) specifies that all message dates 
will be in this format: message time followed by message date followed 
by message time zone (but only if the message did not originate from 
your local time zone). Example: 02:56PM11/21/97-0800.

Age-sensitive—If this is on, message dates are displayed differently 
based on the age of the messages. The three age categories are RECENT, 
OLD, and ANCIENT. The age of a message is measured from the date 
and time at which the message was composed or sent, based on the 
sender’s e-mail package, and this depends on your setting for the Display 
dates using option. RECENT messages are all those that are "younger" 
than the hours you specify in the Hours to be OLD field. ANCIENT 
messages are all those that are older than the "expiration time" entered in 
the Hours to be ANCIENT field. OLD messages are all those whose age 
falls between that of RECENT and ANCIENT messages: they are older 
than the number of hours specified in the Hours to be OLD field, but 
younger than the number of hours specified in the Hours to be ANCIENT 
field. The date display format for all messages falling in the RECENT, 
OLD, and ANCIENT categories is determined by your entry in the 
RECENT format, OLD format, and ANCIENT format fields, respectively.

RECENT format [default: %1]—Your entry in this field determines the 
format in which the dates of RECENT messages are displayed. RECENT 
messages are all those younger than the number in the Hours to be OLD 
field. The default RECENT format of %1 and the default Hours to be OLD 
of 24 means that all messages from the past 24 hours are displayed with 
the time.

Hours to be OLD [default: 24]—Your entry in this field determines the 
point at which RECENT messages become OLD messages. The default 
entry of 24 hours means that messages become OLD after one day.

OLD format [default: %3]—Your entry in this field determines the format 
in which the dates of OLD messages are displayed. OLD messages are 
those that are older than the Hours to be OLD but younger than the 
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Hours to be ANCIENT. The default OLD format of %3, the default Hours 
to be OLD of 24, and the default Hours to be ANCIENT of 168 means that 
all messages older than one day and younger than one week are 
displayed with the day of the week.

Hours to be ANCIENT [default: 168]—Your entry in this field deter-
mines the point at which OLD messages become ANCIENT messages. 
The default entry of 168 hours means that messages become ANCIENT 
after a week.

ANCIENT format [default: %2]—Your entry in this field determines the 
format in which the dates of ANCIENT messages are displayed. 
ANCIENT messages are all those older than the number in the Hours to 
be ANCIENT field. The default entry of %2 and the default Hours to be 
ANCIENT of 168 means that all those messages older than a week are 
displayed with the date.

Format Key—Use the format key to determine how to program entries in 
the Fixed field and the format fields (RECENT, OLD, and ANCIENT) of 
this Options window. In each field, enter %1 to stand for the Time, enter 
%2 to stand for the Date, enter %3 to stand for the Day of the week, and 
enter %4 to stand for the Time zone, but only if the message did not origi-
nate from the local time zone. Separate each entry with a space to 
improve readability of the display output: for example, %1%2%4.

Labels

The Labels options determine the title and color of the seven labels that 
can be used to categorize messages.

To display the Labels options window, do the following:

1 From the Tools menu, select Options.

2 Scroll and click the Labels icon. The Labels options window is 
displayed.
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                              Labels options window

To change a label title, type the new title in the field to the right of the 
label number. To change a label color, single-click on the label number to 
display the Color dialog.

                                    The Color dialog
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You can select from one of the pre-defined Basic colors or create your 
own Custom colors. To assign a basic color to a label, select the color and 
click OK. To create a custom color, click the Define Custom Colors button 
to display the custom colors palette.

                          The custom colors palette 

To define a custom color, do the following:

1 Select one of the 16 custom color boxes. 

2 Using the mouse pointer, click anywhere on the color palette to select 
the color Hue and Saturation. Use the color control bar to the right of 
the color palette to adjust the color. 

3 When you are satisfied with the color, click Add to Custom Colors. 

4 Once you have completed creating the custom colors, select the 
desired label color and click OK.

Getting Attention

The Getting Attention options determine what Eudora does when it is 
running in the background and wants your attention, or when new mail 
arrives.

To display the Getting Attention options window, do the following:
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1 From the Tools menu, select Options.

2 Scroll and click the Getting Attention icon. The Getting Attention 
options window is displayed.

                      Getting Attention options window

Listed below are field descriptions for Getting Attention:

Use an alert dialog box—If this is on, an alert dialog notifies you when 
new mail is received.

Open mailbox—If this is on, mailboxes are automatically opened when 
new mail arrives in them, and the first unread message of the last unread 
batch of messages is selected.

Play a sound—If this is on, a sound is played when Eudora needs atten-
tion. To select a sound (.wav) file, click on the button below the Play a 
sound option (the button is empty by default). The Select sound file 
dialog is then displayed, allowing you to select a sound.

Generate filter report—If this is on, a filter report is generated when 
filters are used. Filter reports are displayed in the Filter Report window, 
accessed from the Tools menu. Note that this option must be on in order 
for such reports to be displayed in that window. 
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Extra Warnings

The Extra Warnings options determine whether you are warned before 
making a possible mistake. Most of the warnings are displayed with an 
option to stop that warning from being displayed again. You can toggle 
warnings to be either on or off.

To display the Extra Warnings options window, do the following:

1 From the Tools menu, select Options.

2 Scroll and click the Extra Warnings icon. The Extra Warnings options 
window is displayed.

                      Extra Warnings options window

Listed below are field descriptions for Extra Warnings:

Delete unread mail—If this is on, you are warned if you try to delete mail 
that is marked unread.

Delete queued mail—If this is on, you are warned if you try to delete 
mail that is queued to be sent (marked "Q," or "T" for timed-queue) in the 
Out mailbox.

Delete unsent mail—If this is on, you are warned if you try to delete 
messages that are marked sendable (with a bullet in the Out mailbox) but 
not yet sent.
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Queue a message with no subject—If this is on, you are warned if you 
try to queue a message that contains no text in the Subject line. It is 
considered a point of e-mail etiquette to give each message a subject.

Queue a message bigger than ? K [default: 500]—If this is on, you are 
warned if you try to queue or send a message that is greater in size than 
the specified number. This number must be between 0 and 1000000 (one 
million, no commas).

Quit with messages queued to be sent—If this is on, you are warned if 
you try to quit Eudora while there are still queued messages in your Out 
mailbox.

Empty the Trash mailbox—If this is on, you are warned if you try to 
empty the Trash mailbox (one way is with the Special menu Empty Trash 
command). Once messages are deleted from the Trash, they are 
completely gone from your system.

Start Eudora and it’s not the default mailer—If this is on, you are 
warned if you try to start Eudora when it’s not the default mailer. When 
Eudora is the default mailer, <mailto:> commands open a Eudora 
message, regardless of what application the command is in.

Switch views for Find—If this is on, you are warned if you try to perform 
a Find operation (using the Edit menu Find submenu) while viewing an 
incoming message using the Microsoft Internet Explorer version 3.0 
viewer. The warning indicates that Eudora will switch to a different 
viewer to complete the Find operation. Eudora uses Internet Explorer (IE) 
3.0 as the default viewer if IE 3.0 is installed on your system and the Use 
Microsoft’s viewer option is turned on in the Viewing Mail Options.

Advanced Network

These options control some of Eudora’s advanced network functions.

Important. Consult your e-mail administrator before modifying any of 
these options.

To display the Advanced Network options window, do the following:
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1 From the Tools menu, select Options.

2 Scroll and click the Advanced Network icon. The Advanced Network 
options window is displayed.

                  Advanced Network options window

Listed below are field descriptions for Advanced Network:

Use asynchronous Winsock calls for—This option lets you select asyn-
chronous calls for Database functions (default on) and/or All others 
(default on) when using the Winsock connection method. There are two 
methods of making Winsock calls using TCP/IP stacks: blocking and 
asynchronous. Because of the ability to handle error conditions more 
gracefully, asynchronous is the preferred method. However, some 
TCP/IP stacks do not handle asynchronous calls correctly, so if you are 
experiencing trouble with your Winsock connection, make sure both of 
these asynchronous options are off.

Network open timeout ? seconds [default: 60]—This option lets you set 
the number of seconds before an attempt to make a network connection 
will time out. For some servers (especially those with heavy loads), the 
attempt to establish the network connection can take longer than it takes 
to send data back and forth once the connection has been made. A 
familiar example: When you are browsing the World Wide Web, you may 
find that it takes a while to connect to a server, but then, once you have 
connected to the server, the Web page can seem to download very 
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quickly. This option therefore gives you the ability to set a different (and 
usually longer) timeout for establishing the network connection than the 
timeout after the connection has been made (the latter timeout is set via 
the Network timeout after ? seconds option, below).

Network timeout after ? seconds [default: 60]—This option lets you set 
the number of seconds before an established network connection will 
time out. See the discussion above for the Network open timeout ? 
seconds option.

Network buffer size of ? bytes [default: 4096]—This option lets you set 
the size, in bytes, of the buffer that Eudora uses to transfer information to 
and from the server.

Note. If you are having trouble transferring large messages, the size of 
this buffer may be decreased.

Cache network info—This option causes Eudora to remember the results 
of previous database functions when using the Winsock connection 
method. This speeds up database functions within a single Eudora 
session.

Unload Winsock DLL after closing socket—This option causes Eudora 
to unload the Winsock DLL after closing the socket. This is useful if you 
don’t want Eudora to keep your Winsock DLL open continuously.

Automatically dial & hangup this connection—If this is checked, the 
specified dialup connection (referred to in Windows NT 4.0 as a "phone-
book entry") is used when Eudora does any network operation. This 
option is only available if you have installed the dial-up networking 
services with Windows 95 or Windows NT 4.0.

Entry—Use the pop-up menu to select a dial-up connection in this field.

Username—This specifies the username for the auto connection.

Save password—If this is on, the auto connection password is saved in 
Eudora so that you do not have to re-enter it after you exit and restart 
Eudora. If you select Forget Password(s) from the Special menu, you will 
need to re-enter the password the next time you check mail.
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MAPI

The MAPI Options control the Eudora MAPI Server. Eudora’s MAPI 
support allows you to quickly attach documents to e-mail messages 
directly from the application that created the document. Without MAPI, 
users must first save the document, remember what folder the document 
is in, switch to Eudora, and then remember to manually attach the docu-
ment to the outgoing message.streamlines this process dramatically. To 
e-mail the current, open document from your word processor, select the 
Send command from your word processor’s File menu. This automati-
cally activates Eudora and attaches a snapshot of the open document to a 
new composition message.MAPI system standardizes how messages are 
handled by client applications so that each client application does not 
have to have custom code for each target messaging application. MAPI 
accomplishes this by providing a standard application program interface 
used by all MAPI-enabled client applications.additional MAPI feature 
supported by Microsoft Office applications is the ability to add a “routing 
slip” to a Word, Excel, or PowerPoint document. This routing slip 
contains a list of e-mail recipients obtained from the MAPI subsystem. 
Once a document has an embedded routing slip, then it can be semi-auto-
matically routed as an attachment via e-mail to all recipients listed in the 
routing slip. Once the routing is complete, the annotated document is 
returned back to the original sender.

To display the MAPI options panel, do the following:

1 From the Tools menu, select Options.

2 Scroll and click the MAPI icon. The MAPI options panel is displayed.
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                               MAPI options window

Listed below are field descriptions for MAPI:

Use Eudora MAPI server—If Never is selected, the Eudora MAPI server 
is off and is never automatically loaded. If When Eudora is running is 
selected, the Eudora MAPI server is on when Eudora is running. If 
Always is selected, the Eudora MAPI server is on and is always loaded on 
startup.

Delete MAPI attachments—If Never is selected, MAPI attachments are 
never deleted from the attachment directory. If After sending message is 
selected, MAPI attachments are deleted from the attachment directory 
when their corresponding messages are sent. If When message emptied 
from Trash is selected, MAPI attachments are deleted from the attach-
ment directory when their corresponding messages are emptied from the 
Trash.

Send single MAPI file attachment as inline attachment (TXT and 
HTML files only)—Turn this on when you need to have the MAPI client 
send a single TXT or HTML file as an attachment with no body text. 
Eudora turns off the Text As Attachment button in the outgoing message 
toolbar (if it is on), so that the document is sent to the recipient as inline 
text in the message body. This allows MAPI clients, such as Internet 
Explorer, to pass Web pages and other HTML and TXT documents right 
into the body of the Eudora message. (The Text As Attachment button, if 
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turned on in the outgoing message toolbar, instructs Eudora to attach text 
files, such as TXT and HTML, to the message rather than incorporating 
the text into the message as part of the message body. The default state of 
this button is controlled by the Put text attachments in body of message 
option in the Attachments options. 

Auto Configure

Eudora needs just a few pieces of information in order for you to send 
and receive mail. Normally you enter this information in the first few 
panels of the Options panels, but if you like, you can use the Auto 
Configure options to retrieve these basic settings from an ACAP server. 
Your e-mail administrator can let you know if such a server is available to 
you. ACAP, which stands for Application Configuration Access Protocol, 
is a communications protocol that lets e-mail and other applications store 
setup data on and retrieve it from a central server.

To display the Auto Configure options panel, do the following:

1 From the Tools menu, select Options.

2 Scroll and click the Auto Configure icon. The Auto Configure options 
panel is displayed.

                      Auto Configure options window
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Listed below is the field description for Auto Configure:

Server Name—In this field, enter the name of the ACAP server you wish 
to connect to in order to retrieve the Eudora settings. If you are not sure 
what to enter here, see your e-mail administrator.

User Name—Enter your user name required for connection to the ACAP 
server. Your e-mail administrator can provide you this name if you do 
not know it.

Password—Enter your password required for connection to the ACAP 
server. See your e-mail administrator for your ACAP password.

Retrieve Settings Now—After you have entered the Server Name for the 
ACAP server, your User Name, and your Password (see above), click this 
button to retrieve your Eudora settings from the ACAP server. The 
retrieved settings replace your current Eudora settings.

Automation

The Automation options let you control and exchange information with 
Eudora from other programs that support the Windows Automation 
Interface, such as Microsoft Visual Basic.gives you external access to 
Eudora mail folders, mailboxes, and messages, and to the Eudora appli-
cation itself. With automation enabled, you can create, delete, and move 
Eudora mail folders, mailboxes, and messages, as well as get notification 
of these three operations when they are performed manually. You can 
also get lists of the subfolders under folders and of the messages within 
mailboxes.more information on the automation feature, visit the Web site 
www.eudora.com, where you can find up-to-date automation SDKs 
(Software Developer’s Kits) and documentation.

To display the Automation options panel, do the following:

1 From the Tools menu, select Options.

2 Scroll and click the Automation icon. The Automation options panel 
is displayed.
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                         Automation options window

Listed below is the field description for Automation:

Automation enabled from this machine—If this option is on, you can 
perform the automation operations described above from the computer 
on which Eudora is installed.

Kerberos

These options control the Kerberos authentication system. If your 
network uses Kerberos for authentication, the appropriate options are 
provided by your e-mail administrator.

To display the Kerberos options panel, do the following:

1 From the Tools menu, select Options.

2 Scroll and click the Kerberos icon. The Kerberos options panel is 
displayed.
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                            Kerberos options window

Listed below is the field description for Kerberos:

Kerberos POP3 port—This is the port that the Kerberos POP server is 
listening on.

Realm—This is the network realm that the Kerberos server resides in.

Service name [default: rcmd]—This is the type of service that you’re 
requesting.

Service format [default: %1.%4@%3]—This is the name of the ticket that 
Eudora requests from the Kerberos server. The formatting key below this 
field indicates what to enter. Enter %1 to stand for the service name 
entered in the Service name field; enter %2 to stand for the full domain 
name of the POP host; enter %3 to stand for the realm entered in the 
Realm field; enter %4 to stand for the name of the POP host.

Miscellaneous

The Miscellaneous options determine additional Eudora capabilities that 
are not categorized with other functions.

To display the Miscellaneous options window, do the following:
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1 From the Tools menu, select Options.

2 Scroll and click the Miscellaneous icon. The Miscellaneous options 
window is displayed.

                    Miscellaneous Options Window

Listed below are the field descriptions for Miscellaneous:

Switch messages with: arrow keys—If this is on and there is an incoming 
message window open on the screen, the up or left arrow key closes the 
current message and opens the previous message in the mailbox, and the 
down or right arrow key closes the current message and opens the next 
message in the mailbox. If this is on and the Show message preview pane 
option is on in the Viewing Mail options , and keyboard focus is currently 
in the preview pane of an open mailbox window, then pressing the 
unmodified arrow keys changes the view in the preview pane going up 
or down the message summary list, as appropriate. If the Unmodified 
arrow keys option is turned off, the arrow keys can be used to move the 
cursor (insertion point) in messages and the preview pane.

Note. Even if Unmodified arrow keys is on, the arrow keys do not 
switch messages if there is an outgoing message topmost on the 
screen.
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Ctrl+arrow keys—If this is on, you can switch messages by holding 
down the Ctrl key and pressing the arrow keys. The switching behavior is 
as described above under the Unmodified arrow keys option. The 
Ctrl+arrow keystrokes do not work when composition windows are open 
on the screen.

Alt+arrow keys—If this is on, you can switch messages by holding down 
the Alt key and pressing the arrow keys. The switching behavior is as 
described above under the Unmodified arrow keys option. The 
Alt+arrow keystrokes do work when composition windows are open on 
the screen.

Empty Trash when exiting—If this is on, the Trash mailbox is emptied 
when you exit Eudora. If this is off, the Trash is only emptied when you 
select Empty Trash from the Special menu.

Say OK to alerts after ? second(s) [default: 120]—If this is on, any alerts 
that announce a problem with the network communication automatically 
go away after the specified number of seconds. Many network problems 
are temporary, so this allows Eudora to try the communication again. 
This is most useful if you have automatic mail-checking enabled for any 
of your accounts.

Turbo redirect by default—If this is on and you select Redirect To, a redi-
rected message is created with the specified recipient, the message is 
queued, and the original message is deleted.

Intercept Netscape mailto URLs—If this is on, then when you execute a 
Netscape "mailto:" command, by clicking on an active e-mail address in a 
Web page, a new Eudora message opens.

Include outdated ‘Return-Receipt-To’—If this is off, Eudora uses the 
“Disposition-Notification-To:” header in return receipt requests to 
request that you be sent a notification when your message is displayed by 
the recipient. If this is on, Eudora also sends the "Return-Receipt-To:" 
header in return receipt requests. This header is understood by some 
older mail delivery systems, and may return you a receipt when your 
message is delivered to your recipient’s mailbox. The 
"Return-Receipt-To:" header cannot give you any information about 
whether or not your recipient displayed your mail, and is not supported 
by many newer mail delivery systems.
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Automatically expand nicknames— If this is on, nicknames in message 
headers are replaced with the real addresses when you switch fields.
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Eudora Reference Guide Introduction
Introduction

This section of the manual describes the menu commands in Eudora. 
Each menu is displayed, and each command is described. However, by 
pressing the [Shift] key while opening a menu, you can change the 
commands displayed on the menus. These keys are shown after the 
bolded title of the command.

If there is a shortcut to the menu command, it is displayed to the right of 
the command on each menu. Just press the [Ctrl] and the appropriate 
keyboard character to access that command. 

File menu

This menu provides basic file and mail functions.

         File menu

New File—Create a new text file.

Open File...—Open an existing text file.

Open Attachment—Open the attachment on the cursor line. (Shortcut: 
Enter.)

Close—Close the current window.
[Shift] Close—Close all windows.
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Save—Save the changes to the topmost window.
[Shift] Save—Save the changes to all open windows.

Save As...—Save the current message(s) to a text file.

Save As —StationerySave the current message to a stationery file. (Statio-
nery files have the .sta extension and by default are saved in your Statio-
nery directory.)

Send Queued Messages—Send all messages that have been queued for 
delivery.
[Shift] Send Queued Messages—Display the Mail Transfer Options 
dialog.

Check Mail—Pick up new mail from the incoming mail server (POP or 
IMAP).
[Shift] Check Mail—Display the Mail Transfer Options dialog.

Print...—Print the current message(s) or window.

Print Preview—Display the Print Preview window, giving a preview of 
how the current item(s) to be printed will look when printed.

Print Setup...—Display the Print Setup window, letting you set the 
printing options.

Exit—Exit (quit) the Eudora application.

Edit menu

This menu provides text editing tools.
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       Edit menu

Undo—Reverse the most recent action taken. You can undo up to the last 
50 actions.

Redo—Redo the most recent action that was undone with the Undo 
command. You can redo up to the last 50 actions (depending on how 
many were undone).

Cut—Delete the selected text and place it on the clipboard.

Copy—Copy the selected text and place it on the clipboard.

Paste—Paste the contents of the clipboard.

Paste As Quotation—Paste the contents of the clipboard as quoted text, 
preceding each line of text by the quote character, which is a right 
angle-bracket (>) if there are no styles, or an “excerpt bar” (|) if there are 
styles.

Clear—Delete the selected text.

Text—Apply text styles to the selected text or paragraph. Includes such 
commands as Typewriter (fixed-width font), Bulleted List, Clear Format-
ting (remove all styles), and Make Hyperlink (create a clickable link from 
a piece of text, or an embedded graphic, to a URL).
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Insert—Insert objects in the body of a composition message. Includes the 
commands Picture... (insert an embedded JPEG graphic file) and Hori-
zontal Line (insert a horizontal rule as a separator).

Select All—Select the entire contents of a message or a mailbox.

Wrap Selection—Insert carriage returns into the selection, as appro-
priate.

Finish Address Book Entry—Complete the partial text of a nickname.

Insert Recipient—Insert the chosen recipient. (The submenu lists the 
recipients on your Quick Recipient List.)

Find—Search for the designated character string.

Sort—Sort the message summaries in a mailbox by the selected column, 
in ascending order.
[Shift] Sort—Sort the message summaries in descending order by the 
selected column.

Check Spelling—Perform a spelling check on the entire message or the 
selected text (displays the Check Spelling dialog).
[Shift] Check Spelling—Perform an inline spelling check on the entire 
message or the selected text (highlights misspelled words in red 
double-underline: right-click on a highlighted word to correct the 
spelling).

Message Plug-ins—Launch the installed message plug-in, as appro-
priate. See the section “Plug-ins (Extended Messaging Services)” in this 
Reference Manual for more details.

Mailbox menu

This menu lets you open a mailbox or bring an open mailbox to the front, 
and create new mailboxes and mail folders.
74

QUALCOMM Incorporated



Eudora Reference Guide Message menu
Mailbox menu

In—Open the mailbox where incoming messages are stored until deleted 
or transferred to another mailbox.

Out—Open the mailbox where messages you compose are stored, where 
queued messages are held until actually sent, and where copies of sent 
messages may be initially stored.

Trash—Open the mailbox where deleted messages are stored.

New...—Display the New Mailbox dialog to create a new mailbox.

[Your Mailboxes]—Open the selected mailbox that you have created, or 
create a new mailbox in a folder that you have created. Below the New... 
command on the Mailbox menu, all of your top-level mailboxes are listed, 
followed by all of your top-level mail folders. (Mail folders can contain 
other mail folders as well as mailboxes.) Navigate through the menu 
system to open a mailbox that resides within a folder, or to create a new 
mailbox within that folder, using the New... command on the folder 
submenu.

Message menu

This menu lets you create, send, and delete messages.

Note. If you hold down the Shift key while selecting any of the message 
composition commands in the top half of the Message menu — from New 
Message down to and including Redirect To — the Message Options 
dialog is displayed, which lets you select the Personality, and optional 
Stationery, for the composition message.
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 Message menu

New Message—Open a new message composition window.

Reply—Reply to the sender of the current message.

Reply to All—Reply to the sender and all original recipients of the 
current message.

Forward—Forward the current message to someone else.

Redirect—Redirect the current message to someone else.

Send Again—Resend a message rejected by the mail system. (You can 
also use this command to resend saved or copied messages to avoid 
retyping message body text or message header text.)

New Message To—Send a message to someone on your Quick Recipient 
List.

Forward To—Forward a message to someone on your Quick Recipient 
List.

Redirect To—Redirect a message to someone on your Quick Recipient 
List.
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New Message With—Open a new message window with the selected 
stationery.

Reply With—Open a reply message with the selected stationery. Reply to 
the sender of the message only.

Reply to All With—Open a reply message with the selected stationery. 
Reply to the sender and all original recipients of the message.

Attach File [to New Message]—Attach a file to the current message or a 
new message.

Attach—Use an attachment plug-in to create and attach a special file to 
the current message or a new message. Example: A QUALCOMM 
PureVoice voice-message attachment. See the section “Plug-ins 
(Extended Messaging Services)” in this Reference Manual for more 
details.

Send Immediately or Queue For Delivery—Send the message right now, 
or put it in the queue to be sent the next time queued messages are sent.

Change—Change the queueing, status, priority, label, server status, or 
personality (e-mail account) of the selected messages or current message. 

Note. Changing the personality changes the associated stationery and 
signature.

Delete—Transfer the current message into the Trash mailbox (POP 
server), or mark the message for deletion (IMAP server).

UnDelete—Unmark the message for deletion (IMAP server only).

Remove Deleted Messages—Remove all messages marked for deletion 
(IMAP server only). Removes these messages from both your PC and the 
IMAP server.

Transfer menu

This menu lets you transfer the current message(s) to another mailbox: 
either an existing mailbox, or a new mailbox that you create.
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Note. Holding down the Shift key while selecting any of the items on the 
Transfer menu transfers a copy of the current message(s) to the selected 
mailbox and leaves the original messages where they are.

Transfer menu

In—Transfer the current message(s) to the In mailbox.

Out—Transfer the current message(s) to the Out mailbox.

Trash—Transfer the current message(s) to the Trash mailbox.

New...—Display the New Mailbox dialog to create a new mailbox and 
transfer the current message(s) into that mailbox, all in one step. You can 
specify to create the mailbox only, and not transfer the messages.

[Your Mailboxes]—Transfer the current message(s) into the selected 
mailbox that you have created, or into a new mailbox that you create. 
Below the New... command on the Transfer menu, all of your top-level 
mailboxes are listed, followed by all of your top-level mail folders. (Mail 
folders can contain other mail folders as well as mailboxes.) Navigate 
through the menu system to transfer the current message(s) to a mailbox 
that resides within a folder, or to create a new mailbox within that folder 
and transfer the current message(s) into that mailbox, all in one step, 
using the New... command on the folder submenu.

Special menu

This menu lets you use additional Eudora functions.
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    Special menu

Filter Messages—Filter the open message or the selected message(s) 
against all the manual filters in your Filters list. Useful for filtering 
messages after you have received them, especially after creating new 
filters (you must make these filters manual whether or not you also make 
them automatic).

Make Filter—Open the Make Filter dialog to create a simple transfer 
filter based on information in the open message or the selected 
message(s).

Make Address Book Entry...—Create an Address Book entry from the 
current message, the Address Book, or the Directory Services window.

Add as Recipient—Add the selected text (usually a full e-mail address) 
to your Quick Recipient List.

Remove Recipient—Select a recipient from this submenu and the recip-
ient is removed from your Quick Recipient List.

Empty Trash—Delete all messages from the Trash mailbox. As a result of 
this action, these messages are completely removed from your computer.

Compact Mailboxes—Reclaim unused space in all mailboxes.

Forget Password(s)—Make Eudora forget your passwords, so that next 
time mail is checked for one of your password-controlled mail accounts, 
the password must be entered first. Useful if you step away from your 
desk in a non-secure area.
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Change Password...—Change the account password for one of your pass-
word-controlled incoming mail accounts (POP or IMAP server). It is good 
security practice to change your password(s) periodically.

Message Plug-ins Settings...—Open the Installed Message Plug-ins 
dialog, which lets you set the options for those installed message plug-ins 
that have settable options. In the open Installed Message Plug-ins dialog, 
click on the desired plug-in (scroll through the list if necessary) and then 
click the Settings... button, which will only be available if the plug-in has 
settings. In the Plug-in Settings dialog that is displayed, set the options 
you want and click OK to save your changes and close the dialog. When 
you are finished setting your plug-in options from the Installed Message 
Plug-ins dialog, click the Close button to close the dialog. Example: 
QUALCOMM’s PureVoice voice-messaging plug-in gives you the option 
to begin recording automatically, as soon as you launch the plug-in. See 
the section “Plug-ins (Extended Messaging Services)” in this Reference 
Manual for more information.

Tools menu

All of Eudora’s tool windows can be opened from this menu, as well as 
the Options dialog. Select a tool window name to open that window, or 
select Options... to open the Options dialog and set your options

 Tools menu

Filters—Display the Filters window, which lets you create, modify, and 
remove message filters.
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Filter Report—Display the Filter Report window, which provides a 
report of all filter operations (transfers to mailboxes) since the last time 
Eudora was opened. Note: For these filter reports to be generated, you 
must turn on the Generate filter report option in the Getting Attention 
Options (Tools:Options:Getting Attention). This option is off by default.

Mailboxes—Display the Mailboxes window, which lets you manage 
your mailboxes and mail folders.

File Browser—Display the File Browser window, which lets you browse 
through your desktop and drag attachments to new messages and other-
wise (partially) manage your files and folders. (The File Browser window 
is not a full replica of MS Windows Explorer.)

Stationery—Display the Stationery window, which lets you create, 
manage, and apply your stationery files.

Signatures—Display the Signature window, which lets you create, 
manage, and apply your signatures.

Personalities—Display the Personalities window, which lets you create, 
modify, manage, and apply your personalities (e-mail accounts).

Address Book—Display the Address Book window, which lets you 
create, manage, and apply entries that contain nicknames (shorthand 
names for groups of e-mail addresses) and associated information. In the 
Address Book window, you can also create multiple Address Book files 
for storing nickname entries. Nicknames provide a quick and convenient 
way to address e-mail, especially to multiple recipients and to people you 
correspond with frequently.

Directory Services—Display the Directory Services window, which lets 
you look up people on the Internet, on your local network (e.g., within 
your organization), or in your Eudora Address Book(s). The Directory 
Services window is similar to an Internet “White Pages.”

Options...—Display the Options dialog, which lets you set options for a 
variety of categories in Eudora. In the open Options dialog, click on a 
category in the Category list, then set the options for that category. Click 
OK to save your changes and close the dialog. (You can make changes in 
multiple categories before clicking OK.) See “Setting Eudora Preferences” 
in this Reference Manual for descriptions of all the options in all catego-
ries.
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Window menu

All of Microsoft Windows’ standard Window menu options are listed in 
this menu, as well as, below the separator line, the names of all normal 
Eudora windows that you currently have open (tabbed window groups 
are listed by the currently active window in the tabbed group). Note that 
this menu does not apply to docked or floating Eudora windows. (See the 
Eudora User manual section “Managing Your Windows in Eudora” for 
more information on normal, docked, floating, and tabbed windows.)

Window menu

Cascade—Display all open normal Eudora windows in a cascading 
fashion (diagonally offset from each other in a stack).

Tile Horizontal—Display all open normal Eudora windows in a tiled 
(edge to edge) fashion with horizontal edges touching (top to bottom).

Tile Vertical—Display all open normal Eudora windows in a tiled (edge 
to edge) fashion with vertical edges touching (left to right).

Arrange Icons—Arrange all Eudora window icons, representing mini-
mized normal Eudora windows, in a line at the bottom of the Eudora 
main window work area. These icons are also represented by buttons on 
the Eudora taskbar.

Send To Back—Send the topmost open normal Eudora window to the 
back of all displayed windows. A tabbed window group is considered a 
single window for this purpose.

[Your Windows]—All normal Eudora windows that are open are 
displayed here. Tabbed windows are represented as single windows, 
identified by the currently active window in the group. Select the desired 
window to bring that window (or the tabbed group containing it) to the 
front of all displayed windows.
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Help menu

Eudora’s Online Help Topics, the Context Sensitive Help, the Tip of the 
Day, and the About Eudora dialog are all available from this menu, along 
with Technical Support information, the Registration dialog, and System 
Configuration information to be inserted in new composition messages 
when reporting bugs or when corresponding with the Eudora Technical 
Support group.

   Help menu

Topics—Display the online Help contents.

Context Sensitive Help—Display context sensitive Help. Selecting this 
command attaches a question mark icon to the mouse pointer. You then 
click on any screen object in Eudora (icon, menu command, text field, 
etc.), and a Help window is displayed containing help for that object.

Technical Support—Display a Eudora Help window containing informa-
tion on getting more help and, optionally, contact information for the 
Eudora Technical Support group. See the Eudora User Manual sections 
“Technical Support” and “Registering Your Copy of Eudora” for more 
information on how to obtain technical support directly from the Eudora 
Technical Support group if you are eligible to receive it. If you are eligible 
for this support and you complete the registration process, direct contact 
information for the Eudora Technical Support group will be displayed in 
this help window.

Tip of the Day—Display the Tip of the Day dialog.

Register Eudora...—Display the Registration dialog, which lets you 
register your copy of Eudora. See the Eudora User Manual section 
“Registering Your Copy of Eudora” for registration instructions.
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Insert System Configuration—Insert text containing detailed informa-
tion about your system configuration into the message body of a new 
composition message. Eudora-related configuration files may also be 
attached to the composition message when you select this command. Use 
this feature when reporting bugs or when corresponding with the Eudora 
Technical Support group.

About Eudora...—Display the About Eudora screen, which contains 
information on this release, on the Eudora web site, and developer and 
support team credits.
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Modifiers

Many operations in Eudora can be implemented by holding down one or 
more “modifier” keys. Eudora uses the Shift, Ctrl, and Alt keys as modi-
fiers.

Shift + Check Mail—Display the Mail Transfer Options dialog to define 
the interaction with your POP account.

Shift + Queue/Send—Open the Change Queueing dialog.

Shift + New Message command—Display the Message Options dialog to 
select a personality for the new message, and optional stationery. The 
Shift key also modifies these other Message menu commands to bring up 
the Message Options dialog: Reply, Reply to All, Forward, Redirect, Send 
Again, New Message To, Forward To, and Redirect To.

Shift + Insert Recipient—Insert the address(es) instead of the nickname.

Shift + Ctrl + ,—Expand the nicknames in the current field to their real 
addresses (the cursor must be in the appropriate field).

Shift + Finish Address Book Entry—Finish the Address Book entry with 
the address(es) instead of the nickname.

Shift + Sort command—Sort in descending order.

Shift + Transfer—Put a copy of the current message in the selected 
mailbox and leave the original where it is.

Shift + Wrap Selection—Remove the carriage returns from the selected 
text (unwrap).

Shift + Save—Save changes to all open windows.

Shift + Close—Close all open windows.

Shift + Exit—Set all open windows to open again when Eudora is next 
started.

Shift + Check Spelling—Perform an “inline” spelling check of the entire 
message or selected text. Misspelled words are highlighted in red 
double-underline. Right-click on a highlighted word and select the 
correct spelling from a popup menu.
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Shift + Space—Switch the status of the open incoming message, or one or 
more selected incoming messages, from “read” to “unread” or from 
“unread” to “read.”

Ctrl + Space—Reset the current or selected text in the message body of a 
composition window to the default character formatting.

Ctrl + Drag window or toolbar—Temporarily suspend docking while 
dragging a dockable window or the main toolbar.

Alt + Drag toolbar button—Move the button on the toolbar.

Shortcuts

The shortcuts for Eudora functions are as follows:

Ctrl +0 Open Out mailbox

Ctrl +1      Open In mailbox

Ctrl +6      Check spelling

Ctrl +’      Paste as quotation

Ctrl +;      Find next

Ctrl +, Finish address book entry (nickname)

Ctrl +A Select all

Ctrl +B Make text bold

Ctrl +C Copy to clipboard

Ctrl +D Delete

Ctrl +E Send immediately or Queue for delivery

Ctrl +F Open Find window

Ctrl +H Attach document

Ctrl +I Make text italic

Ctrl +J Filter messages
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Ctrl +K Make address book entry (nickname)

Ctrl +L Open Address Book

Ctrl +M Check mail

Ctrl +N New message

Ctrl +O Open file

Ctrl +P Print

Ctrl +Q Exit (quit) Eudora

Ctrl +R Reply

Ctrl +S Save current window

Ctrl +T Send queued messages

Ctrl +U Make text underlined

Ctrl +V Paste from clipboard

Ctrl +W Close window

Ctrl +X Cut to clipboard

Ctrl +Y Directory Services

Ctrl +Z Undo

Arrows Move from one message to another in a mailbox 
(depends on your Miscellaneous Options).

Enter Select the outlined button in any dialog, alert, or           
window; open the selected messages or open/edit the 
selected item(s); or open the attachment on the cursor 
line.

Space Open a selected message summary or close the current 
message. For long messages, scroll the message down 
one page.

Esc Stop any operation currently in progress.

Delete Delete the selected text or item.
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F1 Display help.

F2 Rename the selected item in a tool window (e.g., the 
Mailboxes window or the Address Book).

F3 Find again.

Alt + F3 Enter the selected text in the Find window.

F5 Refresh the view in the File Browser window.

F6 Toggles between the two halves of a split window (in 
composition windows, the Address Book, the Filters 
window, and, when the preview pane is displayed, 
mailbox windows).

Ctrl + F6 Send the topmost window to the back of all displayed 
windows.

F7 Show or hide one half of a split window (current 
window only): in composition windows, show/hide the 
message header; in mailbox windows, show/hide the 
message preview pane (if it is set to display).

Home Scroll to the beginning of the mailbox window or to the 
beginning of the line in a message.

End Scroll to the end of the mailbox window or to the end of 
the line in a message.

Page Up, 
Page Down Scroll up or down through the window.
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Introduction

Eudora uses Simple Mail Transfer Protocol (SMTP) to transfer your 
outgoing mail to your SMTP server machine, which in turn uses SMTP to 
send your mail to the world at large. Mail from the world at large arrives 
on your incoming Post Office Protocol (POP) or Internet Message Access 
Protocol (IMAP) mail server, where it waits for Eudora to pick it up with 
either POP version 3 or IMAP version 4. The mail Eudora sends and 
receives is constructed in accordance with RFC 822 and RFC 2045 
(MIME).

       Eudora mail transport overview, POP (similar for IMAP)

Outgoing Mail

When you send an e-mail message to someone, Eudora uses SMTP to 
send the mail to your local SMTP server computer. That computer then 
sends the mail to your add5.01ressee’s computer, also (usually) by means 
of the SMTP protocol.

Your Macintosh POP/SMTP 
Server

The World at Large

POP 
Check Mail

SMTP 
Send Queued Messages

SMTP

Your PC

Check Mail

Send Queued Messages
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Why doesn’t Eudora talk directly to your addressee’s computer? For one 
thing, it would take a lot longer for your mail to leave your PC, because 
your PC would have to call up each addressee’s computer and deliver 
your mail. For another, some computers are “hard to find”; it’s much 
better to let another computer “hunt” for your addressee than to make 
your PC do it. Finally, sometimes your addressee’s computers won’t be 
available when you want to send mail. The SMTP server handles this by 
holding your mail until the other computer is ready to accept it, elimi-
nating the inconvenience of having unsent messages hanging around on 
your PC.

Incoming Mail

When somebody sends you mail, other computers use the SMTP protocol 
to deliver the mail to your POP or IMAP server. Your POP or IMAP 
server puts mail in your “mail drop,” where it stays until the Eudora 
program picks it up. When you check your mail, Eudora uses POP 
version 3 or IMAP version 4 to pick up your mail and move it to your PC.

Why doesn’t Eudora use SMTP to receive your mail? SMTP works best 
when the computers it knows about are always ready for mail. Unless 
you wanted to run Eudora 24 hours per day, seven days a week, SMTP 
wouldn’t work very well for you. It also doesn’t work well in lab environ-
ments, where you might use any number of different PCs.

More Information

If you want to know more about the Internet in general, consult the book 
Internetworking with TCP/IP, by Douglas Comer, 1988, Prentice-Hall ISBN 
0-13-470154-2 025.

If you want to know more about SMTP, RFC 822, POP version 3, and 
MIME, the official standards are:

RFC 821, “Simple Mail Transfer Protocol,” by Jonathan B. Postel

RFC 822, “Standard for the Format of Internet Text Messages,” by Dave 
Crocker

RFC 1939, “Post Office Protocol, Version 3,” by Marshall Rose
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RFC 2045, “Multipurpose Internet Mail Extensions,” by Ned Freed and 
Nathaniel Borenstein

You can find the RFCs by anonymous ftp to ds.internic.net, in the rfc 
directory. Or, in your Web browser, go to 
<http://ds.internic.net/ds/dspg1intdoc.html>. See Internetworking with 
TCP/IP for details.
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Anonymous ftp (ftp.eudora.com)

QUALCOMM’s Eudora Division has an anonymous ftp server, 
ftp.eudora.com, that has information and software related to Eudora. 
These are located within the eudora directory. Included are POP3, Ph, 
and password changing servers, the srialpop program, current product 
information, dialup files, and more. Also look under the directory 
eudora/eudorapro/windows/extras.

Eudora Information

The information in this manual was correct at the time of printing. 
However, things happen very quickly in the electronic world, meaning 
that some of this information may already be out of date. For the very 
latest information about Eudora, send e-mail to 
eudora-info@eudora.com.

Obtaining an Internet E-mail Server

Post Office Protocol (POP) and Internet Message Access Protocol (IMAP) 
Servers are available for a variety of platforms. If you would like to run a 
POP or an IMAP server on your own system, we suggest the following 
servers:

■ Windows NT – QUALCOMM’s Eudora WorldMail™ Server. World-
Mail supports POP3 and IMAP4 as well as LDAP and Ph directory 
services. Microsoft Windows NT 4.0 Server or Workstation is 
required.

■ Macintosh – QUALCOMM’s Eudora Internet Mail Server™ (EIMS). 
EIMS supports POP3 as well as Ph directory services. EIMS requires a 
Macintosh 68030 or higher (Mac IIx, IIcx, SE/30, or better) or a 
PowerPC.

■ UNIX – QUALCOMM’s QPopper. QPopper 2.4 is available via anyon-
ymous ftp from ftp.eudora.com. QPopper versions are available for a 
number of UNIX systems.
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■ VAX/VMS – VAX/VMS systems may try either the Multinet package 
from TGV, or IUPOP3, available via anonymous ftp from 
ftp.indiana.edu.

For information on QUALCOMM’s family of Internet E-mail Servers, 
send e-mail to <eudora-rep@eudora.com> or visit the World Wide Web 
site <http://www.eudora.com>.

Ph Server Source Code

A server for the Ph protocol is available via anonymous ftp from 
ftp.eudora.com.

Password Change Server

Three sample UNIX servers for Eudora’s Change Password... command 
(on the Special menu) are available via anonymous ftp from 
ftp.eudora.com.

Windows Sockets Products

Demos of Windows Sockets 1.1 compliant stacks and applications are 
available via anonymous ftp from papa.indstate.edu in the directory 
winsock-l. They are also available on ftp.cica.indiana.edu in the direc-
tory pub/pc/win3/winsock.

For those with World Wide Web (WWW) browsers, try the following 
sites:

The Consummate Winsock Applications list:http://www.cwsapps.com/
The Ultimate Collection of Winsock Software:http://www.tucows.com/
Stardust Technologies:http://www.stardust.com/wsd/
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Kerberos

You can get the necessary files and information for setting up Kerberos 
authentication in Eudora from ftp.eudora.com in the directory 
eudora/eudorapro/windows/extras/kerberos. Be sure to read the installa-
tion instructions to ensure that Kerberos is set up properly.

To learn more about the Kerberos authentication system, anonymous ftp 
to athena-dist.mit.edu and begin in the pub/kerberos directory.

Spelling Dictionaries

There are additional spelling dictionaries that are compatible with 
Eudora’s built-in spelling checker. They are available via anonymous ftp 
from ftp.eudora.com in the directory eudora/eudo-
rapro/windows/extras/dictionaries. To configure Eudora to use these 
dictionaries, look at the Online Help (select Topics from the Help menu) 
under EUDORA.INI Settings File, [Settings] MainLex files.
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What is MIME?

“MIME” stands for Multipurpose Internet Mail Extensions. MIME serves 
two major purposes — it allows mail applications to tell one another 
what sort of data is in mail, and it also provides standard ways for mail 
applications to encode data so that it can be sent through the Internet mail 
system.

MIME Encoding

The Internet uses the “SMTP” protocol to move mail around. SMTP is 
limited to the US-ASCII character set (see the “Mail Transport” section of 
this manual). This is a problem for people who speak languages other 
than American English and so need accented characters or non-American 
letters, or for people who want to use special symbols like the bullet.

MIME provides a way around this restriction. It offers two encodings, 
“quoted-printable” and “base64.” These encodings use US-ASCII char-
acter codes to represent any sort of data you like, including special char-
acters or even non-text data.

Quoted-printable is used for data that is mostly text, but has special char-
acters or very long lines. Quoted-printable looks just like regular text, 
except when a special character is used. The special character is replaced 
with an “=” and two more characters that represent the character code of 
the special character. So, a bullet in quoted-printable looks like “=95.”

However, there are some other things that quoted-printable does. For 
one, since it uses an “=” to mean something special, equals signs must 
themselves be encoded (as “=3D”). Second, no line in quoted-printable is 
allowed to be more than 76 characters long. If your mail has a line longer 
than 76 characters, the quoted-printable encoding will break your line in 
two, and put an “=” at the end of the first line, to signal to the mail reader 
at the other end that the two lines are really supposed to be one. Finally, a 
few mail systems either add or remove spaces from the ends of lines. So, 
in quoted-printable, any space at the end of a line gets encoded (as “=20”) 
to protect it from such mail systems.

Let’s try an example. Here’s a passage of text that you might type on your 
PC:

«Il est démontré, disait-il, que les choses ne peuvent 
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être autrement; car tout étant fait pour une fin, tout est 
nécessairement pour la meilleure fin.»

Without any encoding, this might show up on your recipient’s screen as:

+Il est dimontri, disait-il, que les choses ne peuvent 
btre autrement; car tout itant fait pour une fin, tout est 
nicessairement pour la meilleure fin.;

This corruption happens because SMTP cannot handle the special charac-
ters. However, if you and your recipient both have MIME, quoted-print-
able encoding would be used, and your text would show up properly:

«Il est démontré, disait-il, que les choses ne peuvent 
être autrement; car tout étant fait pour une fin, tout est 
nécessairement pour la meilleure fin.»

While your mail was actually in transit, however, it would have looked 
like:

=ABIl est d=E9montr=E9, disait-il, que les choses ne 
peuvent =EAtre =autrement; car tout =E9tant fait pour une 
fin, tout est n=E9cessairement = 
pour la meilleure fin.=BB

Base64 encoding is another way to protect binary data from the SMTP 
mail system. However, Base64 makes no attempt to be legible, and is 
most appropriate for non-text data.

MIME Labeling

The other important part of MIME is that it lets mailers communicate 
what kind of data is in a message (or part of a message). The primary 
mechanism used for this is the Content-Type header:

Content-Type: text/plain; charset=iso-8859-1

A content-type header is divided into three parts; the content type, the 
content subtype, and the parameters. In this case, the content type is 
“text,” meaning the message contains mostly legible text. The content 
subtype is “plain,” which means there aren’t any formatting commands 
or anything like that embedded in the text. Finally, “charset=iso-8859-1” 
is a parameter; in this case, it identifies the character set the message uses.
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The major content types are:

textlegible text

imagepictures and graphics

audiosound

videomoving pictures

messagemessages or pieces of messages

multipartseveral different kinds of data in a single message

Practical Issues

There are really only two things you sometimes need to do with Eudora 
and MIME. One is that it may occasionally be necessary to turn off 
quoted-printable encoding. Another is that you may want to know how 
to define mappings between PC file extensions, MIME types, and Macin-
tosh types.

Turning Off Quoted-Printable Encoding

Eudora automatically uses quoted-printable encoding if your mail 
contains special characters. Eudora also uses quoted-printable encoding 
for attached plain text files. If your recipients don’t have MIME, 
quoted-printable may hurt more than it helps. If that’s the case, just turn 
off the QP button in the message Toolbar when you are sending text files 
to those recipients.

Mapping Between File Extensions, MIME Types, and 
Macintosh Types

Since Eudora needs to have the appropriate extensions on attachment 
filenames in order to open them up from the message, Eudora has the 
ability to map between file extensions, MIME types and subtypes, and 
Macintosh creators and types. Messages received by Eudora can grab the 
MIME type/subtype and/or Macintosh creator/type from an attachment 
and map that into the correct file extension. Also, on outgoing messages, 
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Eudora can make sure that attachments are encoded with the correct 
MIME type/subtype and/or Macintosh creator/type depending on the 
file extension of the attachment being sent.

Eudora knows about some MIME types. However, since new MIME 
types are being defined all the time, it may be necessary to add to 
Eudora’s knowledge from time to time. Adding new mappings between 
the various types only requires editing the EUDORA.INI file with a text 
editor (like the one that comes with Eudora).

There is a section in the EUDORA.INI file labeled [Mappings], followed 
by some entries, one per line. Each entry is called a map. A map defines 
when the mapping should occur (which can be “in,” “out,” or “both”), 
followed by an equals sign and five parameters. These five parameters 
are (in order) the PC file extension, the Macintosh creator code, the 
Macintosh type, the MIME type, and the MIME subtype. Here are some 
sample entries:

[Mappings]
both=gif,,,image,gif
both=mpg,,,video,mpeg
both=doc,MSWD,,,
in=xls,XCEL,,,
out=xls,XCEL,XLS4,,
both=eps,,EPSF,application,postscript

A map marked “in” only tries to match the map to messages that you 
receive. A map marked “out” only tries to match the map to messages 
that you send. A map marked “both” tries to match the map to both 
incoming and outgoing messages.

The first map above says that any incoming MIME message that has a 
part type of “image” and subtype of “gif” will get saved to a file with the 
extension “.gif.” It also specifies that outgoing messages that have an 
attachment with the file extension “.gif” will get the MIME type of 
“image” and subtype of “gif” if the encoding method of the message is 
MIME. The second map is similar to the first map in structure, but uses a 
different file extension and MIME type and subtype.

You can use map entries to move between PC file extensions and Macin-
tosh creator and type as well. The third map says that if an incoming 
message has an attachment with the Macintosh creator “MSWD” (which 
is the Macintosh creator for Microsoft Word) then the file extension of the 
attachment when saved to disk should be “.doc” (the file extension that 
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Word for Windows uses). Since the map is marked as “both,” it will also 
give attachments with the extension “.doc” on outgoing messages the 
Macintosh creator of “MSWD” if the encoding method of the message is 
BinHex.

Note that the Macintosh type from this map is empty. This allows 
multiple types to be recognized with just one mapping. This is nice for 
“in” maps because it allows you to cover a range of creator/type pairs 
with one map. You must be careful in using this type of map with an 
“out” or “both” mapping, though, because an outgoing attachment that 
matched this map would have a Macintosh creator, but no Macintosh 
type. Some Macintosh applications cannot open files with a missing type. 
Microsoft Word for the Macintosh can open files without a type, so this 
map is fine being marked “both.”

Microsoft Excel for the Macintosh is an example of a program that can't 
open a file with an empty type. This is why there are two maps for Excel 
(the fourth and fifth maps above). The incoming map for Excel is like the 
one for Microsoft Word, but the outgoing map explicitly defines the 
Macintosh type.

The last map shows that you can have both Macintosh creator/type and 
MIME type/subtype in one entry. This map says that if an incoming 
message has an attachment that is encoded in MIME and has the “appli-
cation/postscript” type/subtype, or has a BinHex attachment with the 
Macintosh type of “EPSF,” then the resulting file will have an extension 
of “.eps.” Similarly, if an outgoing message has an attachment with the 
extension “.eps” and if the MIME encoding is being used for the message, 
then the attachment will get the “application/postscript” MIME 
type/subtype. If the message was using the BinHex encoding, then the 
attachment would get the Macintosh type of “EPSF.”

But what happens if an attachment matches more than one map? Eudora 
will try and find the best match. For example, if you had the following 
[Mappings] section:

[Mappings]
in=xls,XCEL,,,
in=xlc,XCEL,XLC3,,
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and you received a message with an attachment that had a Macintosh 
creator of “XCEL” and a Macintosh type of “XLC3” (a Microsoft Excel 
Chart), then the file would get an extension of “.xlc” since the first map 
only matched the Macintosh creator, but the second map matched both 
the Macintosh creator and type.

Eudora can receive attachments that have both a MIME type/subtype 
and a Macintosh creator/type. Eudora understands attachments with the 
MIME type/subtype “application/applefile,” which has Macintosh 
creator/type information embedded in it. With this type of attachment, 
Eudora will consider a match with the Macintosh creator/type as a 
“better” match than a match with the MIME type/subtype.

Finally, if an incoming attachment matches two different maps to the 
same degree (e.g., both maps have the same MIME type/subtype with 
different file extensions), then Eudora will use the file extension in the 
first matching map.
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Introduction

As of version 4.0, Eudora no longer supports the built-in Serial Dialup 
(shell) connection method found in previous versions of Eudora. Eudora 
now requires that you use the Microsoft SLIP/PPP Dialup Networking 
connection method that is a standard feature of both Windows 95 and 
Windows NT 4.0.

The Microsoft SLIP/PPP Dialup Networking facility offers the following 
advantages over the retired Eudora Serial Dialup feature:

■ TCP/IP running on top of SLIP/PPP is inherently more reliable than a 
Serial Dialup connection because reliable, end-to-end data transmis-
sion is an integral feature of TCP/IP.

■ A SLIP/PPP dialup connection is application-independent and 
supports TCP/IP, IPX, and NetBEUI protocols. Eudora Serial Dialup 
was not generic and applied specifically to checking and sending mail 
with Eudora.

■ A SLIP/PPP connection supports transmission of binary data, as 
required by the IMAP4 protocol.

■ Microsoft Dialup Networking supports a wider range of modem hard-
ware, and navigation scripts are generally modem-independent.

As with the old Serial Dialup function, Eudora can use Microsoft Dialup 
Networking to automatically dial your mail server, check and/or send 
mail, and then automatically hang up the connection.

General Steps

Following are the general steps necessary to set up Microsoft Windows to 
use Microsoft Dialup Networking. If you have already set up Microsoft 
Dialup Networking and can successfully connect to your Internet Service 
Provider, then skip to the section “Configuring Eudora to Auto-Dial the 
Phonebook Entry” below.
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1 Make sure you have a SLIP/PPP account – You must arrange for 
SLIP/PPP account access through your Internet Service Provider. If 
you can choose between SLIP and PPP, we recommend PPP.

2 Install your modem – Configure Microsoft Windows so that it recog-
nizes your modem hardware.

3 Install networking components – Configure your MS Windows 
networking software to include the TCP/IP protocol.

4 Install Dialup Networking components – Configure your MS 
Windows networking software to include the Microsoft Dialup 
Networking tool and the Remote Access Services.

5 Define a Phonebook entry – The Microsoft Dialup Networking tool 
lets you create multiple “phonebook” entries, one for each of your 
Internet Service Providers. Configure the Phonebook entry to auto-
matically dial the modem, establish a SLIP/PPP session, and, if appli-
cable, auto-configure your IP address and DNS server address(es).

6 Configure Eudora to auto-dial – Eudora can use a Dialup Networking 
Phonebook Entry to automatically dial your mail server, check and/or 
send mail, and hang up the connection when the mail transfer is 
complete.

Configuring Dialup Networking under Windows 95

Dialup Networking is an optional component of Windows 95. Before 
configuring Dialup Networking, you should install your modem and 
make sure the Windows 95 networking software includes support for the 
TCP/IP protocol. Consult your Microsoft documentation for details on 
installing your modem, configuring the TCP/IP protocol, and installing 
the Dialup Networking tools.

After you install Dialup Networking, follow these steps to define a new 
Phonebook entry:

1 Double-click on the My Computer icon to open an Explorer window. 
Then double-click on the Dialup Networking icon to open the Dialup 
Networking folder.

2 Double-click on the Make New Connection button to display the 
Make New Connection Wizard.
114

QUALCOMM Incorporated



Eudora Reference Guide Configuring Dialup Networking under Windows 95
3 Enter the name you want to associate with your Internet Service 
Provider. Also, select your modem in the dropdown list. Then click 
Next.

4 In the edit box, enter the phone number for your Internet Service 
Provider. Then click Next.

5 Click Finish on the last page of the New Connection Wizard to 
complete the creation of the Phonebook entry.

6 In the Dialup Networking folder, right-click on the icon for the Phone-
book entry you have just created, and select the Properties command.

7 While testing your new Phonebook entry, configure Dialup 
Networking to display a terminal window after your modem has 
connected to the remote computer. To do this, click the Configure… 
button to display the modem configuration properties. Select the 
Options tab, then check the Bring up terminal window after dialing 
option. Click OK to accept the change.

8 Back in the Properties dialog for your Phonebook entry, click the 
Server Type… button to display the Server Types dialog. In the Type 
of Dial-Up Server dropdown list, select either SLIP or PPP as appro-
priate. Also, uncheck the NetBEUI and IPX network protocols, but 
make sure that the TCP/IP protocol is checked. Finally, uncheck the 
Log on to network and Enable software compression options.

9 In the Server Types dialog, click the TCP/IP Settings… button to 
display the TCP/IP Settings dialog.

10 If your Internet Service Provider has assigned you a specific (static) IP 
address, select the Specify an IP address option, then enter that 
address in the field. Otherwise, if your provider assigns IP addresses 
dynamically via DHCP (Dynamic Host Configuration Protocol), then 
keep the default Server assigned IP address setting.

11 If your Internet Service Provider supports Dynamic Host Configura-
tion Protocol (DHCP), then the name server addresses will automati-
cally be configured by DHCP, and you should keep the default Server 
assigned name server addresses setting. Otherwise, select the Specify 
name server addresses option, then enter the server addresses 
assigned by your Internet Service Provider. Click OK to accept the 
TCP/IP Settings changes.

12 Back in the Server Types dialog, click OK to accept the changes.
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13 Back in the Phonebook Entry Properties dialog, click OK to accept the 
changes.

14 You should now be back in your Dialup Networking folder. 
Double-click on your new Phonebook entry to dial your Internet 
Service Provider. Your modem should immediately dial the phone 
number defined in your Phonebook entry, and Windows 95 should 
prompt you for your username and password.

15 Once your modem negotiates the connection with the remote system, 
you typically then have to “log in” to that remote system by entering 
the username and password assigned to you by your Internet Service 
Provider. Some systems require that you first press Enter to display a 
login prompt, then enter the username and password. In any event, 
once you are “logged on” (authenticated), some providers automati-
cally start your SLIP or PPP session, while others require that you take 
an extra step, such as typing ppp, to initiate a PPP session. Carefully 
note the exact steps you must take in order to manually log in and 
establish a SLIP/PPP session: you will need this information in order 
to automate the login process, as described below under “Defining a 
Login Script.”

Configuring Dialup Networking under Windows NT 
4.0

Dialup Networking is an optional component of Windows NT 4.0. Before 
configuring Dialup Networking, you should make sure Windows NT 
recognizes your modem and also make sure your Windows NT 
networking software includes support for the TCP/IP protocol. Consult 
your Microsoft documentation for details on installing your modem, 
configuring the TCP/IP protocol, and installing the Dialup Networking 
tools. To properly configure TCP/IP, you may need some information 
from your Internet Service Provider regarding your IP address and your 
DNS server(s).

After you install Dialup Networking, follow these steps to define a new 
Phonebook entry:
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1 Double-click on the My Computer icon to open an Explorer window. 
Then double-click on the Dialup Networking icon to launch the 
Dialup Networking tool.

2 Click the New… button to display the New Phonebook Entry Wizard.

3 Enter the name you want to associate with your Internet Service 
Provider, then click Next to display the Server page.

4 Most Internet Service Providers use a terminal server or a Unix server 
to support dialup users. Therefore, you should generally check all 
three boxes to indicate that (1) you are calling the Internet, (2) it is 
okay to send your plain text password, and (3) the server expects login 
information. Ask your e-mail administrator or your Internet Service 
Provider if you are unsure about these settings. Click Next to display 
the Modem or Adapter page.

5 Select your modem from the list, then click Next to display the Phone 
Number page.

6 In the edit box, enter the primary phone number for your Internet 
Service Provider. If your provider has alternate phone numbers, click 
the Alternates… button and enter the alternate phone numbers. Click 
Next to display the Serial Line Protocol page.

7 Select PPP or SLIP as appropriate to your Internet Service Provider 
(most providers now support PPP), then click Next to display the 
Login Script page.

8 When initially testing dialup connections to your Internet Service 
Provider, we recommend that you select the Display a terminal 
window option. Once you can manually establish a dialup connec-
tion, you can then automate the dialup connection with a login script 
(see “Defining a Login Script” below for details). Click Next to display 
the IP Address page.

9 If your Internet Service Provider has assigned you a specific (static) IP 
address, then enter that address in the field. Otherwise, if your 
provider assigns IP addresses dynamically via DHCP (Dynamic Host 
Configuration Protocol), then keep the default Server assigned IP 
address setting. Click Next to display the Name Server Addresses 
page.
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10 If your Internet Service Provider supports Dynamic Host Configura-
tion Protocol (DHCP), then the name server addresses will automati-
cally be configured by DHCP and you should leave the default 
addresses of 0.0.0.0. Otherwise, enter the server addresses assigned by 
your Internet Service Provider. Click Next to display the final page of 
the Phonebook Wizard.

11 Click Finish to create your new Phonebook entry.

12 Back in the Dialup Networking tool, select your new Phonebook entry 
in the dropdown list, then click Dial to dial your Internet Service 
Provider. Your modem should immediately dial the phone number(s) 
defined in your Phonebook entry.

13 Once your modem negotiates the connection with the remote system, 
you typically then have to “log in” to that remote system by entering 
the username and password assigned to you by your Internet Service 
Provider. Some systems require that you first press Enter to display a 
login prompt, then enter the username and password. In any event, 
once you are “logged on” (authenticated), some providers automati-
cally start your SLIP or PPP session, while others require that you take 
an extra step, such as typing ppp, to initiate a PPP session. Carefully 
note the exact steps you must take in order to manually log in and 
establish a SLIP/PPP session: you will need this information in order 
to automate the login process, as described below under “Defining a 
Login Script.”

Defining a Login Script

Here is a sample login script for an Annex terminal server:

proc main
transmit "^M"
waitfor "Annex username:" until 30
if FALSE == $SUCCESS then

goto Failure
endif
transmit $USERID + "^M"
waitfor "Annex password:" until 30
if FALSE == $SUCCESS then

goto Failure
endif
transmit $PASSWORD + "^M"
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waitfor "Permission granted" until 30
if FALSE == $SUCCESS then

goto Failure
endif
transmit "ppp" + "^M"

Failure:
set screen keyboard on
halt

Done:

endproc

Based on your experience with manually connecting to your Internet 
Service Provider, you may need to change the Annex username: and 
Annex password: strings to match the prompts displayed by the machine 
to which you are connecting. You may or may not need to transmit the 
ppp command after the system accepts your username and password. 
The Dialup Networking tool automatically replaces the $USERID and 
$PASSWORD variables with your Dialup Networking username and 
password so that you don’t expose your username and password in an 
unencrypted plain text file.

To use this login script, you must first save the file to a known location on 
your disk. By convention, Dialup Networking script files have an SCP file 
extension.

To use the script under Windows 95:

■ Launch the Dial-up Scripting Tool found on the Start 
:Programs:Accessories menu.

■ Select the Phonebook entry from the Connections list box and enter 
the script filename in the File name field.

■ Click the Apply button to accept your changes.

■ Click the Properties button to display the properties dialog for your 
Phonebook entry.

■ Click the Configure button to display the modem properties dialog. 
Then select the Options tab.
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■ Uncheck the Bring up terminal window after dialing option. Now 
click OK to accept your changes.

■ Back in the properties dialog for your Phonebook entry, click OK to 
accept your changes.

To use the script under Windows NT 4.0:

■ Open the Dialup Networking tool, and from the dropdown list select 
the Phonebook entry you want to change.

■ Click the More button, then select the Edit entry and modem proper-
ties… item from the button menu.

■ In the Edit Phonebook Entry dialog, select the Script tab, click the Run 
this script option, and then enter the name of your saved login script.

This script is compatible with both Windows 95 and Windows NT 4.0 
Dialup Networking tools. If the login sequence fails, then the script will 
halt, leaving you free to attempt a manual login via the popup Dialup 
Networking terminal window.

Creating a Desktop Phonebook Shortcut

You may find it convenient to create a desktop shortcut to your Phone-
book entry, something we recommend.

To create a Phonebook shortcut under Windows 95:

1 Open the Dialup Networking folder, then drag a Phonebook icon to 
your Windows desktop.

2 To rename the shortcut label, select the shortcut icon and press F2, or 
just click on the shortcut label twice, slowly.

To create a Phonebook shortcut under Windows NT 4.0:

1 Open the Dialup Networking tool, click the More button, and select 
the Create shortcut to entry… item.

2 Choose a name for the shortcut in the Save dialog, then save the 
shortcut to your Desktop folder.
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To test the Dialup Networking connection, double-click on the shortcut 
icon on your Desktop. Once your Phonebook entry successfully and auto-
matically creates a TCP/IP connection to your Internet Service Provider, 
you are ready to configure Eudora to automatically dial the Phonebook 
entry.

Configuring Eudora to Auto-Dial the Phonebook 
Entry

If you connect to your Internet Service Provider with a modem, you can 
easily configure Eudora to automatically “dial on demand” using 
Microsoft Dialup Networking. Eudora only needs a connection to your 
provider when performing network operations such as checking or 
sending mail, or when performing a directory services lookup. When 
Eudora is configured to auto-dial, it automatically hangs up the connec-
tion when the network operation is complete.

Before you can configure Eudora to auto-dial, you must create and 
configure a Microsoft Dialup Networking Phonebook entry to automati-
cally connect to your Internet Service Provider (see the procedures 
above).

To auto-dial a Dialup Networking Phonebook entry, start Eudora, select 
Options... from the Tools menu to display the Options dialog, then click 
on the Advanced Network category. Check the Automatically dial & 
hangup this connection option. In the Entry list, select the Phonebook 
entry you want to dial. In the Username edit box, enter the username, if 
any, that is required to log in to your Internet Service Provider (this is the 
value that is substituted for the $USERID variable in your Dialup 
Networking script). Check the Save password option if you want Eudora 
to save your Dialup Networking password in the Eudora.ini file. If you 
leave the Save password option turned off, then Eudora will prompt you 
to enter your password each time it auto-dials the Phonebook entry.

To test the auto-dial capability, make sure your modem is not already 
connected, then select the Check Mail command from the File menu in 
Eudora. Eudora will automatically dial your Internet Service Provider, 
log in, establish a TCP/IP connection, transfer any new mail, and auto-
matically hang up when the mail transfer is complete.
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Where to Get More Information on MAPI

For more information, supplementary to this technical report, visit our 
online MAPI FAQ at the web site <http://www.eudora.com/developers>.

What Does MAPI Do?

Eudora’s MAPI support allows users to quickly attach documents to 
e-mail messages directly from the application that created the document. 
Without MAPI, users must first save the document, remember what 
folder the document is in, switch to Eudora, and then remember to manu-
ally attach the document to the outgoing message.

MAPI streamlines this process dramatically. To e-mail the current, open 
document from your word processor, select the Send command from 
your word processor’s File menu. This automatically activates Eudora 
and attaches a snapshot of the open document to a new composition 
message.

The MAPI system standardizes how messages are handled by client 
applications so that each client application does not have to have custom 
code for each target messaging application. MAPI accomplishes this by 
providing a standard application program interface used by all 
MAPI-enabled client applications.

An additional MAPI feature supported by Microsoft Office applications 
is the ability to add a “routing slip” to a Word, Excel, or PowerPoint 
document. This routing slip contains a list of e-mail recipients obtained 
from the MAPI subsystem. Once a document has an embedded routing 
slip, then it can be semi-automatically routed as an attachment via e-mail 
to all recipients listed in the routing slip. Once the routing is complete, the 
annotated document is returned back to the original sender.
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MAPI Overview

Let’s start with a picture:

A MAPI client application is any 16-bit or 32-bit Windows application that 
knows how to access the standard MAPI messaging functions in a library 
known as a DLL (Dynamic Link Library). The functions in the MAPI DLL 
allow a MAPI client application to transparently and generically access a 
MAPI service provider. A MAPI service provider is the application that 
handles the receipt, transmission, and storage of messages. Examples of 
MAPI client applications (“front-ends”) include Microsoft Word and 
Microsoft Excel. Examples of MAPI service providers (“back-ends”) 
include Microsoft Exchange and Microsoft Fax.

Eudora Pro

16-bit MAPI

client application

32-bit MAPI

client application

MAPI.DLL MAPI32.DLL
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All 16-bit client applications use the 16-bit MAPI.DLL and all 32-bit client 
applications use the 32-bit MAPI32.DLL. The MAPI and MAPI32 DLLs 
are “twins” which contain the same list of MAPI functions—they are 
parallel implementations of the 16-bit and 32-bit MAPI functions. These 
DLLs are provided by Microsoft as standard components of Windows 95 
and Windows NT. The MAPI DLLs are normally installed in the 
Windows 95 SYSTEM directory (SYSTEM32 for Windows NT).

As shown in the diagram on the previous page, when a MAPI client 
application wishes to send a document, it simply loads the appropriate 
MAPI library (DLL) and calls the defined MAPI functions. The MAPI 
DLL takes care of routing the messaging and authentication requests to 
the appropriate MAPI service provider application, displaying the 
address book user interface, and returning address book and messaging 
data to the MAPI client application. The MAPI DLL also provides an 
optional user interface for user authentication. For example, the user may 
need to supply a user name and password to the mail system in order to 
“log on” to the mail system. (The Eudora implementation of MAPI does 
not implement authentication since Eudora itself requires authentication 
to access the POP3 and IMAP4 servers.)

Eudora Implementation of MAPI

Eudora implements a subset of the full MAPI library by providing two 
“replacement DLLs” for the standard Microsoft MAPI DLLs. The Eudora 
EUMAPI.DLL is a replacement for the 16-bit Microsoft MAPI.DLL and 
the Eudora EUMAPI32.DLL is a replacement for the 32-bit Microsoft 
MAPI32.DLL. The Eudora MAPI DLLs must be located in the same direc-
tory as the Eudora program.

The Eudora MAPI DLLs implement the standard Simple MAPI functions 
detailed in the MAPI specification. The MAPI specification also defines 
Extended MAPI functions, however, the Eudora MAPI DLLs implement 
only the Simple MAPI subset.

Note. The Eudora MAPI implementation requires all MAPI client appli-
cations to use only the Simple MAPI functions supported by the Eudora 
MAPI DLLs.
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MAPI client applications which use only the basic Simple MAPI calls will 
generally not be able to tell the difference between the Eudora MAPI DLL 
functions and the Microsoft MAPI DLL functions.

It is important to understand that MAPI client applications load the 
MAPI DLL libraries at runtime whenever they need to access the MAPI 
functions. Each client application expects to find either the 16-bit 
MAPI.DLL file or the 32-bit MAPI32.DLL file in a common, applica-
tion-independent location (generally the Windows SYSTEM directory). 
Therefore, it is not sufficient to copy the EUMAPI.DLL and 
EUMAPI32.DLL Eudora DLL files into the Windows SYSTEM directory 
alongside the standard Microsoft MAPI.DLL and MAPI32.DLL files. For 
client applications to find the Eudora MAPI DLLs, the DLL files must be 
named MAPI.DLL and MAPI32.DLL. This creates a conflict since most 
Windows installations will have the MAPI.DLL and MAPI32.DLL files 
preinstalled in the Windows SYSTEM directory to support Microsoft 
Exchange.

Note. Eudora is able to swap the Eudora EUMAPI and EUMAPI32 DLLs 
with the Microsoft MAPI and MAPI32 DLLs when the user launches 
Eudora, and is able to unswap the Eudora MAPI DLLs when the user 
exits Eudora.

This approach gives the user the most flexibility and preserves the user’s 
ability to use Microsoft Exchange and/or Microsoft Fax when Eudora is 
not running. If we “permanently” install the Eudora MAPI DLLs over the 
existing Microsoft MAPI DLLs, then applications (such as the Microsoft 
Fax service bundled with Microsoft Exchange) which rely on the 
Microsoft MAPI DLLs will no longer work. This is clearly unacceptable 
for users who need to use MAPI for both Microsoft Exchange and 
Eudora.

Eudora MAPI Startup Procedure

When launched, Eudora runs the following “swap” procedure when the 
user has selected either the “Always” or the “When Eudora is running” 
MAPI Server option in Eudora (see Tools / Options / MAPI):
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1 Check to see whether or not the Eudora MAPI DLLs are already 
installed in the Windows SYSTEM directory. If so, then finish.

2 Check for existing Microsoft MAPI.DLL and MAPI32.DLL files. If 
found, rename MAPI.DLL to MAPI.000 and rename MAPI32.DLL to 
MAPI32.000. (If a MAPI.000 file already exists, then Eudora uses 
MAPI.001, MAPI.002 etc.)

3 Copy the EUMAPI.DLL and EUMAPI32.DLL files from the Eudora 
program directory to the Windows SYSTEM directory as MAPI.DLL 
and MAPI32.DLL, respectively.

Eudora MAPI Shutdown Procedure

When shutdown, Eudora runs the following “unswap” procedure when 
the user selects either the “When Eudora is running” or “Never” MAPI 
Server option in Eudora (see Tools / Options / MAPI):

1 Check to see whether or not the Eudora MAPI DLLs are already 
installed in the Windows SYSTEM directory. If not, then finish.

2 Delete the Eudora MAPI.DLL and MAPI32.DLL files.

3 Rename the MAPI.000 and MAPI32.000 files, if any, to MAPI.DLL and 
MAPI32.DLL, respectively. (If a MAPI.001, MAPI.002, etc. file exists, 
then Eudora renames the one with the highest number.)

Eudora DLL Swapping Restrictions

It is important to note that there are several restrictions with the above 
Eudora swap and unswap procedures: The Eudora swap and unswap 
procedures can only run successfully if the MAPI.DLL and MAPI32.DLL 
are not currently “in use” by one or more MAPI client applications.

When a MAPI client application loads a MAPI or MAPI32 DLL file, 
Windows “locks” the DLL file while the library is loaded into memory to 
show that the file is “in use.” Eudora can normally detect that the 
MAPI.DLL and/or MAPI32.DLL files are “in use.” If Eudora detects that 
a MAPI or MAPI32 DLL is locked, it displays an error message and skips 
the swap or unswap procedure.
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When Eudora is forced to skip the swap or unswap procedure, this means 
that the MAPI DLLs are in the wrong “state” with respect to Eudora — 
that is, 1) the Microsoft MAPI DLLs could be installed even after Eudora 
starts, or 2) the Eudora MAPI DLLs could be installed even after Eudora 
shuts down. To prevent this from happening, use the following proce-
dure when using Eudora MAPI:

1 Start Windows.

2 Start Eudora.

3 Start any MAPI client applications.

4 Send attachments to Eudora via the installed Eudora MAPI interface.

5 Shutdown all MAPI client applications.

6 Shutdown Eudora.

7 Exit Windows.

Once Eudora’s MAPI DLLs get into the wrong “state” with respect to 
Eudora, you cannot correct the state mismatch until all MAPI client appli-
cations unload the MAPI DLLs and Windows is able to unlock the DLL 
file. Since the MAPI DLLs are shared by multiple MAPI client applica-
tions, Windows does not unlock the MAPI DLL file until the last MAPI 
client application is shut down. Therefore, to force all MAPI client appli-
cations to unload the DLLs, you must shutdown all MAPI client applica-
tions.

Important. When running 16-bit MAPI client applications under 
Windows NT, then Eudora cannot detect the lock placed on the MAPI 
DLLs by Windows unless the SHARE program is running. This means 
that Eudora can inadvertently perform the DLL swap and/or unswap 
procedures while the MAPI DLL is loaded into memory. This almost 
always causes Windows to become unstable and can lead to crashes in 
MAPI client applications as well as in Windows itself.

Note. If you run 16-bit MAPI client applications under Windows NT, 
then you should always run the SHARE program.
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The good news is that Windows 95 implements the SHARE functionality 
without requiring you to explicitly run the SHARE program. By default, 
Windows NT only implements the SHARE functionality for 32-bit appli-
cations. If you are running a 16-bit application under Windows NT, then 
you must run the SHARE program explicitly.
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What to do first

Occasionally, you may encounter a problem or bug when using Eudora. 
This section includes information to help you solve those problems. You 
can also check the Eudora Technical Support Web Pages at 
<http://www.eudora.com/techsupport>.

If you are having problems, try the following:

■ Be sure that you have the current release of Eudora.

■ Be sure that your incoming mail account (POP or IMAP) is set 
correctly. This mail account may be different from your e-mail 
address, so double-check to see that you have entered the proper 
information in the Return address, Mail Server (Incoming), and 
Login Name fields of the Getting Started Options 
(Tools:Options:Getting Started). Incoming mail accounts are usually 
of the form loginname@mailservername.

■ Be sure your SMTP server is set correctly in the SMTP server field of 
the Sending Mail Options (Tools:Options:Sending Mail). This server 
may or may not be the same machine as your POP server.

■ Be sure you are entering your password correctly, paying attention to 
uppercase and lowercase letters (make sure the Caps Lock key is off).

■ Be sure the date is correct on your computer, especially the year.

■ Be sure Eudora can find your winsock.dll. If Eudora cannot find it, be 
sure the Path line in your AUTOEXEC.BAT file includes the directory 
that contains the winsock.dll. Or, if you do not want to edit your 
AUTOEXEC.BAT file, try copying your winsock.dll into your Eudora 
directory.

■ Toggle both of the Use asynchronous Winsock calls for options (turn 
them on if they’re off, or vice versa) in the Advanced Networking 
Options. The two options are Database functions and All others.

■ Run ScanDisk to check for problems on the hard drive.

■ If you’re having trouble with your mailboxes (especially with 
repeated requests to rebuild a mailbox’s table of contents), quit 
Eudora and find the mailbox’s .toc file in the Eudora directory. 
Change the .toc extension to .000, then open Eudora and see if the 
problem persists.
135

QUALCOMM Incorporated



Errors Eudora Reference Guide
■ On Windows 95: If you’re having other problems, especially crashes, 
remove all of the items in your Startup directory (C:\Windows\Start 
Menu\Programs\StartUp), then restart Windows while holding 
down the F8 key. In the Startup menu, select Safe Mode. Then open 
Eudora and see if the problem persists.

Errors

The following are possible errors and alerts you could receive from 
Eudora, and suggestions for fixing them.

“-ERR Maildrop lock busy”

This usually happens after your PC has “hung” during a mail check 
and you are now attempting to re-connect to the mail server. The best 
thing to do is to contact your e-mail administrator and tell them that 
you have a POP3 server process that needs to be disconnected.

“503 Need RCPT (Recipient)”

You must include at least one recipient in the To field of your 
outgoing message in order for the message to be delivered. If you 
have a nickname in the To field, be sure that in the Address Book at 
least one e-mail address or valid nickname is included in the 
Address(es) tab. If the Address(es) tab is blank, there are no recipients 
and this causes the error.

“Error getting a network socket. Cause: no buffer space available 
(10055)”

The buffers the error message is referring to are TCP buffers. TCP/IP 
stacks need buffers in which they can store data that goes to/from the 
network. Since at a low level the data has to be sent to a hardware 
device, the buffers generally have to be in low memory (i.e., < 1MB). 
This is valuable space for most users, so most TCP/IP stacks have a 
way of controlling how many of these buffers the user wants allo-
cated. If you’re using a lot of other network applications at the same 
time (especially the X Window System, which uses a buffer for each 
window), then you might get this error. The other time this error 
might occur is when the TCP/IP stack is not correctly marking buffers 
as being unused, so you have a buffer not being used that the stack 
thinks is being used.
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“Could not rename lmos.tmp to lmos.dat”

Quit Eudora, and go to your Eudora directory. Find the files called 
lmos.tmp and lmos.dat and delete them both (lmos.tmp may not be 
there: that’s not a problem). On your next mail check you may get 
some mail that you have already received, but that should only 
happen once.

Formatting and Printing

The following are possible formatting and printing problems, and 
suggestions for fixing them.

You received a message containing columns and the columns are not 
lining up correctly.

Your message font is probably a proportional font. Change your 
display font in the Fonts Options (Tools:Options:Fonts): set the 
Fixed-width option to a non-proportional font (such as Courier New 
or Courier), and uncheck the Use proportional font by default option.

You have a message that is printing with strange line breaks.

When most e-mail programs send out messages, they insert hard 
returns at around 75-80 characters. (If they didn’t, some e-mail appli-
cations would only be able to display the first 80 characters or so of a 
very long line of text.) What’s happening with your message is that 
the width of the line that fits on the printed page is shorter than 75-80, 
so the hard returns end up in the wrong place.

The solution is to make the print font smaller, or choose a print font in 
which the letters are printed closer together—like Helvetica instead of 
Courier New, for example. To do this, change the Font and Size 
options in the Printer section of the Fonts Options 
(Tools:Options:Fonts).

Miscellaneous

If you want to set up a password check for sending mail, not just checking 
mail:
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SMTP servers, which are used to send mail for most e-mail accounts, 
do not require a password for access the way a POP server does. 
However, if the POP daemon your server is using is descended from 
the UC Berkeley POPper, you can use the POPSend protocol, which 
routes SMTP calls through the POP server, so that the POP server will 
require the password.

If you turn this feature on in your POP server, add this line to the 
Settings section of the Eudora.ini file:

UsePOPSend=1

This means you will have to enter your password to send as well as 
check mail. However, this is not terribly secure, because users who 
know what they are doing can simply remove that .ini file line or 
uncheck the Use XTND XMIT option and disable the feature. But it 
will protect you against inexperienced but unscrupulous users.
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